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1 Preface

1.1 Documentation Overview

This section provides an overview of the R&S Signal Generator user documentation.
You find it on the product page at:

http://www.rohde-schwarz.com/product/SMBV100A.html > "Downloads"

Quick start guide

Introduces the R&S Signal Generator and describes how to set up and start working
with the product. Includes basic operations, typical measurement examples, and gen-
eral information, e.g. safety instructions, etc. A printed version is delivered with the
instrument.

Online help

Offers quick, context-sensitive access to the complete information for the base unit and
the software options directly on the instrument.

Operating manual

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the quick start guide man-
ual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S Signal Generator is not included.

The online version of the operating manual provides the complete contents for imme-
diate display on the Internet.

Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS, https://gloris.rohde-schwarz.com).

 

 

Documentation Overview
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Instrument security procedures manual

Deals with security issues when working with the R&S Signal Generator in secure
areas.

Basic safety instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

Data sheet and brochure

The data sheet contains the technical specifications of the software options, see "Digi-
tal Standards for Signal Generators - Data sheet" on the web site. It also lists the
options and their order numbers.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

Release notes and open source acknowledgment (OSA)

The release notes of the base units list new features, improvements and known issues
of the current firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software. See the product page of the base unit, e.g. at:

http://www.rohde-schwarz.com/product/SMBV100A.html > "Downloads" > "Firmware"

Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics, see http://www.rohde-schwarz.com/appnotes.

1.2 Conventions Used in the Documentation

1.2.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

 

 

Conventions Used in the Documentation

http://www.rohde-schwarz.com/product/SMBV100A.html
http://www.rohde-schwarz.com/appnotes


PrefaceTD-SCDMA, incl TD-SCDMA enhanced features

9Operating Manual 1171.5260.12 ─ 16

Convention Description

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

1.2.2 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

1.2.3 Naming of Software Options

In this operating manual, we explicitly refer to options required for specific functions of
the digital standard.

The name of software options for signal generators vary in the name of the instrument,
but the option name is identical. Therefore we use in this manual the placeholder
R&S SMx/AMU.

Example: 
Naming for an option of the vector signal generator R&S SMBV100A, e.g:
● R&S SMx/AMU-K99, stands for R&S SMBV-K99

The particular software options available for the corresponding instruments are listed
on the back of the title page.

 

 

Conventions Used in the Documentation
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2 Introduction
TD-SCDMA (3GPP TDD LCR) designates a mobile radio transmission method devel-
oped for 3G mobile communication by the China Wireless Telecommunication Stan-
dard group (CWTS). This standard is similar to the 3GPP TDD proposition, but with
greater emphasis placed on GSM compatibility and with a chip rate limited to
1.28 Mcps. TD-SCDMA is one option of UTRA-TDD, called 1.28Mcps TDD or low chip
rate (LCR) TDD.

Option TD-SCDMA (3GPP TDD LCR) enhanced MS/BS tests incl. HSDPA extends the
TD-SCDMA signal generation with the following:
● Simulation of high-speed channels in the downlink (HS-SCCH and HS-PDSCH
● Simulation of high-speed channels the uplink (HS-SICH)
● Channel coding for BCH in real time and a reference measurement channel.

HSDPA (high speed downlink packet access) mode enhances the TD-SCDMA stan-
dard by data channels with high data rates especially for multi-media applications.

TD-SCDMA is a mobile radio standard in which available bandwidth is divided among
subscribers according to frequency (FDMA), time (TDMA) and code (CDMA). The
same frequency is used for both directions of transmission (TDD). Each resource (i.e.
a combination of frequency, code and timeslot) can be used simultaneously by several
base stations or user equipment provided the scrambling codes differ. A cell is under-
stood to be a base station and all user equipment communicating with this base sta-
tion. The R&S Signal Generator simulates a maximum of four cells at the same fre-
quency. The multicarrier mode can be used to simulate more than four cells at the
same frequency or cells at several frequencies.

The TD-SCDMA signals are generated in a combination of realtime mode (real time
channels) and arbitrary waveform mode. Simulation of bit and block errors can be acti-
vated for the channels generated in real time. In arbitrary waveform mode, the signal is
first calculated and then output.

The R&S Signal Generator simulates TD-SCDMA at the physical channel layer.

The following list gives an overview of the options provided by the R&S Signal Genera-
tor for generating a TD-SCDMA signal:
● Configuration of up to four TD-SCDMA cells with variable switching point of uplink

and downlink.
● Freely configurable channel table for each slot and simulation of the downlink and

uplink pilot timeslot.
● Real time generation of one traffic channel and the SYNC channel on the downlink
● Slot modes "Dedicated" and "PRACH" on the uplink.
● Clipping for reducing the crest factor

To play back a signal from a waveform file created by the simulation software
R&S WinIQSIM2, the corresponding R&S WinIQSIM2 digital standard option must be
installed.

 

http://www.cwts.org
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Table 2-1: Parameters of the modulation system TD-SCDMA

Parameter Value

Chip rate 1.28 Mcps

Carrier spacing 1.6 MHz

Data modulation QPSK

Filter Root-raised cosine (0.22)

Channel types Downlink :
● Primary common control physical channel (P-CCPCH)
● Secondary common control physical channel (S-CCPCH)
● Physical forward access channel (F-FACH)
● Downlink pilot timeslot (DwPTS)
● Dedicated physical channel (DPCH)

Uplink :
● Physical random access channel (P-RACH)
● Uplink pilot timeslot (UpPTS)

Dedicated physical channel (DPCH)

Data rates 17.6 kbps, 35.2 kbps, 70.4 kbps to 281.6 kbps depending on channel type

Number of channels 4 cells, each containing max. 7 active slots. Each slot with up to 16 DPCHs and
5 special channels.

Frame structure Frame: 5 ms with 7 (traffic) timeslots.

Timeslot (traffic): 675 µs

Timeslot (DwPTS): 75 µs

Timeslot (UpPTS): 125 µs

The number of symbols transmitted in a slot depends on the symbol rate.

Scrambling code 128 different codes with length of 16 chips

SYNC codes 32 different codes with length of 64 chips

SYNC1 codes 256 different codes with length of 128 chips

Basic midamble codes 128 different codes with length of 128 chips

Spreading code "Orthogonal variable spreading factor code (OVSF)"; spreading factors 1, 2, 4,
8, 16
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3 Modulation System

3.1 TD-SCDMA Signal Structure (Frames and Time Slots)

The TDSCDMA signal is organized in frames of 5 ms length. Each frame comprises
seven traffic time slots (Ts0 to Ts6, each 0.675 ms) and two special time slots (DwPTS
and UpPTS) for synchronization.

Figure 3-1: Structure of TDSCDMA frame

Ts0 is always allocated to the downlink, Ts1 to the uplink. The other time slots are divi-
ded between the two directions of transmission, the switching point being variable.

3.2 DwPTS and UpPTS

In the downlink pilot time slot (DwPTS), the base station sends one of 32 possible 64-
chip SYNC codes. The SYNC code allows the user equipment to synchronize to the
base station. At the same time, the SYNC code defines the value range for the scram-
bling code and the basic midamble code.

Figure 3-2: Structure of DwPTS

The real-valued SYNC sequence is converted into a complex-valued SYNC sequence
by a rotating-vector operation.

This SYNC sequence is divided up into four symbols with 16 chips each. The symbols
are phase-modulated (possible phases are 45°, 135°, 225° and 315°) in order to signal
the frame number of the interleaver.

In the supplied software, all symbols are modulated with 45°.

The uplink pilot time slot (UpPTS) is sent by the user equipment to initiate a call with
the base station (before a P-RACH is sent, for example). The transmitted SYNC1 code

 

 

 

DwPTS and UpPTS
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is randomly selected from eight possible codes. If the base station does not respond to
the UpPTS, the UpPTS is repeated in the next frame.

Figure 3-3: Structure of UpPTS

The UpPTS is a complex-valued signal resulting from the real SYNC1 sequence by a
rotating-vector operation.

3.3 Structure of Traffic Burst

In time slots Ts0 to Ts6, bursts can be sent by the base station or the user equipment,
i.e. in both directions of transmission. The burst structure is identical for both direc-
tions. There are two types of burst, however, which are described in the following.

Figure 3-4: Burst without Layer 1 Control Information

3.3.1 Burst Without Layer 1 Control Information

This type of burst can be used for all physical channels. It comprises two data fields, a
midamble and a guard period.

Figure 3-5: Traffic burst without layer 1 control information

 

 

Structure of Traffic Burst
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The useful data are
● Alternately fed to the I and the Q path (QPSK data modulation),
● Mapped from the 0/1 plane into the –1/+1 plane,
● Spread with the complex spreading code (spreading factor SF = 1, 2, 4, 8 or 16),
● Scrambled with the real-valued scrambling code,
● Weighted with the channel power and
● Filtered (root-raised cosine 0.22)

Since each user sends only one burst per frame, the following gross data rate is
obtained:

The midamble is obtained from the basic midamble by periodic repetition and shifting.
For some channels, the midamble shift can be set in steps of eight chips. The basic
midamble is 128 chips long, while the length for the midamble field in the time slot is
144 chips. Each scrambling code (setting parameter at cell level) is assigned a basic
midamble code.

The midamble is not spread or scrambled.

No signal is transmitted during the guard period. This avoids crosstalk of the burst into
the next time slot at the receiver end.

3.3.2 Burst with Layer 1 Control Information

This type of burst can be used only with DPCHs (dedicated physical channels). It dif-
fers from the "normal" burst only in that the data fields are shortened ahead of and
after the midamble to enable the transmission of layer 1 control information.

Figure 3-6: Traffic burst with layer 1 control information

The burst consists of two fields of data symbols, a fixed-length 144 chip midamble, and
control fields for Synchronization Shift (SS), Transmit Power Control (TPC), and Trans-
port Format Indicator (TFCI). The timeslot is delimited by a 16-chip guard period (GP).

Each data field consists of a maximum of 352 chips.

 

Structure of Traffic Burst
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The Transport Format Indicator field (TFCI) conveys transport format information to the
receiver, which is used by the channel decoder to recover transport channels. The
information is distributed into two segments in one burst (four segments in two burst =
one frame)

The synchronization shift (SS) field is used to inform the other station of a shift of the
burst time ('"00" means that the sync shift is increased, "11" that it is decreased). The
bits are transmitted in M consecutive frames. The shift value is a multiple k of Tchip/8. M
and k are transmitted by signaling. The value for M (Sync Shift Repetition) can be
selected.

Analogously to the Sync Shift field, the power control (TPC) field is used to initiate an
increase or decrease of transmit power.

If the spreading factor SF is lower than 16, the control symbols are transmitted 16/SF
times. Control symbols are treated like data symbols, i.e. they are spread and scram-
bled.

Structure of Traffic Burst
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4 TD-SCDMA User Interface
To access the dialog for setting the TD-SCDMA digital standard, select "Baseband
Block > Config > TD-SCDMA" or press the MENU key and select "Baseband > TD-
SCDMA".

The dialog is split into several sections for configuring the standard.

The upper section of the dialog is where the TD-SCDMA digital standard is enabled,
the default settings are called, and the transmission direction selected.

The valid TD-SCDMA version and the chip rate in use are displayed.

Many of the buttons lead to subdialogs for loading and saving the TD-SCDMA configu-
ration and for setting the filter, trigger, and clock parameters.

4.1 General Settings for TD-SCDMA Signals

The upper dialog section is where the TD-SCDMA digital standard is enabled and reset
and where all the settings valid for the signal in both transmission directions are made.

 

 

General Settings for TD-SCDMA Signals
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In the lower dialog section, the cells can be reset to the predefined settings, parame-
ters of one cell can be copied to another cell, and the total power can be set to 0 dB.
Each cell can be activated or deactivated. Active cells are highlighted blue. Clicking a
cell opens the configuration dialog for setting the cell parameters.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

The TD-SCDMA signal is generated by a combination of realtime mode (enhanced
channels) and arbitrary waveform mode (all the other channels).

On the downlink, one traffic channel and the SYNC channel of cell 1 are generated in
real time. All the other channels are generated in arbitrary waveform mode and added.

In the uplink, all the channels of cell 1 are generated in real time, the other cells are
generated in arbitrary waveform mode and added to the realtime signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:STATe on page 90

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

State Not affected by "Set To Default"

Link Direction Downlink/Forward

Filter Root Cosine

Clipping Off

Power ramping Cosine / 2 chips

Trigger Auto

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRESet on page 88

Save/Recall...
Calls the "Save/Recall" dialog.

From the "Save/Recall" dialog, the "File Select" windows for saving and recalling TD-
SCDMA configurations and the "File Manager" is called.

TD-SCDMA configurations are stored as files with the predefined file extension
*.tdscdma. The file name and the directory they are stored in are user-definable.

The complete settings in the "TD-SCDMA" dialog are saved and recalled.

General Settings for TD-SCDMA Signals
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"Recall TD-
SCDMA Set-
ting"

Opens the "File Select" window for loading a saved TD-SCDMA con-
figuration. The configuration of the selected (highlighted) file is loaded
by pressing the "Select" button.

"Save TD-
SCDMA Set-
ting"

Opens the "File Select" window for saving the current TD-SCDMA
signal configuration.
The name of the file is specified in the "File name" entry field, the
directory selected in the "save into" field. The file is saved by pressing
the Save button
The "Fast Save" checkbox determines whether the instrument per-
forms an absolute or a differential storing of the settings. Enable this
function to accelerate the saving process by saving only the settings
with values different to the default ones. "Fast Save" is not affected
by the "Preset" function.

"File Manager" Calls the "File Manager".
The "File Manager" is used to copy, delete, and rename files and to
create directories.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog? on page 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:LOAD on page 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe on page 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe:FAST on page 90

Data List Management…
Calls the "Data List Management" dialog. This dialog is used to create and edit a data
list.

All data lists are stored as files with the predefined file extension *.dm_iqd. The file
name and the directory they are stored in are user-definable.

The data lists must be selected as a data source from the subdialogs under the individ-
ual function, e.g. in the channel table of the cells.

Note: All data lists are generated and edited by means of the SOURce:BB:DM subsys-
tem commands. Files containing data lists usually end with *.dm_iqd. The data lists
are selected as a data source for a specific function in the individual subsystems of the
digital standard.

Example: Creating and editing the data list
SOUR:BB:DM:DLIS:SEL "d_list1"
SOUR:BB:DM:DLIS:DATA #B1111010101000001111....
SOUR:BB:DM:DLIS:DATA:APP #B1111010101000001111....

General Settings for TD-SCDMA Signals
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DATA on page 128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DATA:DSELect on page 128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:DATA on page 130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:DATA:DSELect on page 130
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA
on page 121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:DSELect
on page 121
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA on page 115
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA:DSELect on page 116
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA
on page 136
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:
DSELect on page 136

Generate Waveform File…
Calls the "Generate Waveform" dialog. This dialog is used to store the current TD-
SCDMA signal as ARB signal in a waveform file.

This file can be loaded in the "ARB" dialog and processed as multicarrier or multiseg-
ment signal.

The file name is entered in the subdialog. The file is stored with the predefined file
extension *.wv. The file name and the directory it is stored in are user-definable.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:WAVeform:CREate on page 91

TD-SCDMA Version
Displays the current version of the TD-SCDMA standard.

The default settings and parameters provided are oriented towards the specifications
of the version displayed.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:VERSion? on page 91

Chip Rate
Displays the system chip rate. This is fixed at 1.28 Mcps.

The output chip rate can be varied in the Filter/Clipping/ARB Settings dialog (see
Chapter 4.2, "Filter / Clipping / ARB Settings", on page 23).

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CRATe? on page 85

General Settings for TD-SCDMA Signals
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Link Direction
Selects the transmission direction.

The settings of the base station or the user equipment are provided in the following
dialog section in accordance with the selection.

"Downlink/
Forward"

The transmission direction selected is base station to user equip-
ment. The signal corresponds to that of a base station.

"Uplink/
Reverse"

The transmission direction selected is user equipment to base sta-
tion. The signal corresponds to that of a user equipment.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:LINK on page 86

Filtering, Clipping, ARB Settings
Calls the dialog for setting baseband filtering, clipping, and the sequence length of the
arbitrary waveform component. The current filter and the clipping state are displayed
next to the button.

The dialog is described in Chapter 4.2, "Filter / Clipping / ARB Settings", on page 23.

Remote command: 
n.a.

Power Ramping…
Accesses the dialog for setting the power ramping.

The dialog is described in section Chapter 4.3, "Power Ramping", on page 27.

Remote command: 
n.a.

Trigger - Marker
Calls the dialog for selecting the trigger mode and trigger source, for configuring the
marker signals, and for setting the time delay of an external trigger signal (see Chap-
ter 4.4, "Trigger/Marker/Clock Settings", on page 29).

The currently selected trigger mode and trigger source are displayed next to the but-
ton.

Remote command: 
n.a.

Execute Trigger
Executes trigger manually.

A manual trigger can be executed only if an internal trigger source and a trigger mode
other than "Auto" have been selected.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXECute on page 96

Arm
Stops signal generation manually.

The "Arm" button is displayed only if the trigger modes "Armed Retrigger" or "Armed
Auto" have been selected.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:ARM:EXECute on page 96

Clock
Calls the dialog for selecting the clock source and for setting a delay, see Chapter 4.4,
"Trigger/Marker/Clock Settings", on page 29.

Remote command: 
n.a.

Reset All Cells
Resets all cells to the predefined settings. The reset applies to the selected link direc-
tion. The following table gives an overview of the settings. The preset value for each
parameter is specified in the description of the remote-control commands.

Parameter Value

"Cell Configuration"  

State Off

(Use) Scrambling Code On

Scrambling Code (value) 0

SYNC-DL Code 0

SYNC-UL Code 0

Basic Midamble Code ID 0

Number of Users 16

Switching Point 3

DwPTS Power 0.0 dB

"Slot Configuration"  

State Off

Slot Mode (only in uplink) Dedicated

Channel Configuration  

State Off

"Channel Type" Depending on channel number

Current User 1

Slot Format 0

Spreading Factor 16

Spreading Code 0

Power 0 dB

Data Source PRBS: PN9, Data Pattern: 0

Number of TFCI bits 0

TFCI Value 0
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Parameter Value

Number of Sync Shift & TPC bits 0 & 0

Sync Shift Pattern 1

Sync Shift Repetition M 1

TPC Source/TPC Pattern 01

Read Out Mode Continuous

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:RESet on page 88

Copy Cell...
Copies the settings of a cell to a second cell.

"Copy From Source"
Selects the cell whose settings are to be copied.

"To Destination"
Selects the cell whose settings are to be overwritten.

"Accept" Starts the copy process.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:COPY:SOURce on page 85
[:SOURce<hw>]:BB:TDSCdma:COPY:DESTination on page 85
[:SOURce<hw>]:BB:TDSCdma:COPY:EXECute on page 85

Predefined Settings
Access the dialog for setting predefined configurations, see Chapter 4.5, "Predefined
Settings", on page 37 .

Remote command: 
n.a.

Adjust Total Power to 0dB
Sets the power of an enabled channel so that the total power of all the active channels
is 0 dB. This does not change the power ratio among the individual channels.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:POWer:ADJust on page 86

Total Power
Displays the total power of the active channels for the selected link direction.
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The total power is calculated from the power ratio of the powered up code channels
with modulation on. If the value is not equal to 0 dB, the individual code channels are
internally adapted so that the "Total Power" for achieving the set output level is 0 dB.
The power ratios are retained.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:POWer[:TOTal]? on page 87

Test Setups/Models
Accesses the dialog for selecting one of the test models defined in the TD-SCDMA
standard and the self-defined test setups.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel on page 90

Select Cell
Selects the cell and accesses the corresponding dialog with cell-related settings, see
Chapter 4.6, "Cell Configuration", on page 38.

Remote command: 
n.a.

Cell On / Cell Off
Activates or deactivates the cells.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:STATe on page 109

4.2 Filter / Clipping / ARB Settings

► To access this dialog, select "Main dialog > Filter/Clipping/ARB Settings".
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The dialog comprises the settings, necessary to configure the baseband filter, to
enable clipping and adjust the sequence length of the arbitrary waveform compo-
nent

4.2.1 Filter Settings

The upper section comprises the settings required for configuring the baseband filter.

Filter
Selects the baseband filter.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:FILTer:TYPE on page 92

Rolloff Factor or BxT
Sets the filter parameter.

The filter parameter ("Folloff Factor" or "BxT") depends on the currently selected filter
type. This parameter is preset to the default for each of the predefined filters.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:APCO25 on page 93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:COSine on page 93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:GAUSs on page 93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:PGAuss on page 94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:RCOSine on page 94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:SPHase on page 95

Cutoff Frequency Factor
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASs on page 94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASSEVM on page 94

Chip Rate Variation
Enters the chip rate.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CRATe:VARiation on page 86

4.2.2 Clipping Settings

This section comprises the settings required for configuring the clipping.

Clipping State
Switches baseband clipping on and off.
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Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.

TD-SCDMA signals can have high crest factors in particular if a large number of chan-
nels and many inactive slots are involved.

High crest factors entail two basic problems:
● The nonlinearity of the power amplifier (compression) causes intermodulation

which expands the spectrum (spectral regrowth).
● Since the level in the D/A converter is relative to the maximum value, the average

value is converted with a relatively low resolution. This results in a high quantiza-
tion noise.

Both effects increase the adjacent-channel power.

Since clipping the signal not only changes the peak value but also the average value,
the effect on the crest factor is unpredictable. The following table shows the effect of
the clipping on the crest factor for typical scenarios.
Table 4-1: Changing the crest factor by clipping (vector mode |i+q|) for signal configurations with dif-

ferent output crest factors. 100 % clipping levels mean that clipping does not take place.

Clipping Level Downlink +
Uplink:

48 DPCHs"

"minimum crest"

Downlink:

48 DPCHs

"minimum crest"

Downlink +
Uplink:

10 DPCHs

"average crest"

Downlink:

10 DPCHs

"average crest"

100 % 9.47 dB 11.47 dB 7.78 dB 9.71 dB

80 % 8.77 dB 10.75 dB 6.26 dB 8.33 dB

50 % 7.33 dB 9.42 dB 6.51 dB 8.64 dB

20 % 5.82 dB 8.10 dB 4.56 dB 6.95 dB

10 % 5.69 dB 8.11 dB 4.56 dB 6.95 dB

5 % 5.80 dB 8.26 dB 4.56 dB 6.95 dB

The following pictures demonstrate the effect of clipping with mode "Vector (|i+jq|)",
using a signal configuration with 10 active DPCHs.
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Figure 4-1: Constellation diagram of the signal without clipping, shows the level mapping

Figure 4-2: Constellation diagram with clipping level 380 %, vector mode.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLIPping:STATe on page 92

Clipping Level
Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLIPping:LEVel on page 92

Clipping Mode
Selects the clipping method. A graphic illustration of the way in which the methods
work is given in the dialog.
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"Vector | i + q
|"

The limit is related to the amplitude | i + q |. The I and Q components
are mapped together, the angle is retained.

"Scalar | i | + |
q |"

The limit is related to the absolute maximum of all the I and Q values |
i | + | q | .
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLIPping:MODE on page 92

4.2.3 ARB Settings

This section comprises the settings required for configuring the ARB.

Sequence Length ARB
Changes the sequence length of the arbitrary waveform component of the signal. This
component is calculated in advance and output in the arbitrary waveform generator. It
is added to the realtime signal components.

The number of chips is determined from this sequence length (1 Frame =10 ms) and
the chip rate. At 1.2288 MChips/s, a frame equals 12800 chips.

In pure amplifier tests with several channels and no real time channels, it is possible to
improve the statistical properties of the signal by increasing the sequence length.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:SLENgth on page 95

4.3 Power Ramping

The "Power Ramping Settings" dialog contains the shape and time parameters
required for configuring the baseband power ramp.
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► To access these settings, select "TD-SCDMA > Power Ramping".

This dialog comprises the settings required for power ramping.

Ramp Function
Selects the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.

"Linear" The transmitted power rises and falls linear fashion.

"Cosine" The transmitted power rises and falls with a cosine-shaped edge.
This causes a more favorable spectrum than the Linear setting.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRAMp:SHAPe on page 88

Ramp Time
Sets the power ramping rise time and fall time for a burst.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRAMp:TIME on page 88

Rise Delay
Sets the offset in the rising edge of the envelope at the start of a burst. A positive value
causes a delay and a negative value causes an advance.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRAMp:RDELay on page 87

Fall Delay
Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
causes a delay and a negative value causes an advance.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRAMp:FDELay on page 87

In Baseband Only
Activates or deactivates power ramping for the baseband signals.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:PRAMp:BBONly on page 87

Power Ramping
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4.4 Trigger/Marker/Clock Settings

To access this dialog, select "Main dialog > Trigger/Marker".

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

The "Marker Mode" section is where the marker signals at the MARKER output con-
nectors are configured.

The "Marker Delay" section is where a marker signal delay can be defined, either with-
out restriction or restricted to the dynamic section, i.e., the section in which it is possi-
ble to make settings without restarting signal and marker generation.

The "Clock Settings" section is where the clock source is selected and - in the case of
an external source - the clock type.

The buttons in the last section lead to subdialog for general trigger, clock and mapping
settings.

 

Trigger/Marker/Clock Settings



TD-SCDMA User InterfaceTD-SCDMA, incl TD-SCDMA enhanced features

30Operating Manual 1171.5260.12 ─ 16

4.4.1 Trigger In

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

Trigger Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma[:TRIGger]:SEQuence on page 99

Signal Duration Unit
Selects the unit for the entry of the length of the signal sequence to be output in the
Single trigger mode. Available units are chip sequence length (CLS), chips, or frames.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLUNit on page 98

Signal Duration
Enters the length of the signal sequence to be output in the "Single" trigger mode.

Use this parameter to output part of the signal deliberately, an exact sequence of the
signal, or a defined number of repetitions of the signal.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLENgth on page 98

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:RMODe? on page 97

Arm
Stops the signal generation until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:ARM:EXECute on page 96

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXECute on page 96

Trigger Source
Selects trigger source. This setting is effective when a trigger mode other than "Auto"
has been selected.
● "Internal"

The trigger event is executed by "Execute Trigger".
● "Internal (Baseband A/B)"

(two-path instruments)
The trigger event is the trigger signal from the second path

● "External (Trigger 1/2)"
The trigger event is the active edge of an external trigger signal, supplied at the
TRIGGER 1/2 connector.
Use the "Global Trigger/Clock Settings" dialog to define the polarity, the trigger
threshold and the input impedance of the trigger signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SOURce on page 98

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBV instruments:

Trigger/Marker/Clock Settings
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For or two or more R&S SMBVs configured to work in a master-slave mode for syn-
chronous signal generation, configure this parameter depending on the provided sys-
tem trigger event and the properties of the output signal. See the table below for an
overview of the required settings.
Table 4-2: Typical Applications

System Trigger Application "Sync. Output to External Trig-
ger"

Common External Trigger event
for the master and the slave
instruments

All instruments are synchronous
to the external trigger event

ON

All instruments are synchronous
among themselves but starting
the signal from first symbol is
more important than synchronicity
with external trigger event

OFF

Internal trigger signal of the mas-
ter R&S SMBV for the slave
instruments

All instruments are synchronous
among themselves

OFF

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is outputted. After elapsing of the inter-
nal processing time, the output signal is synchronous to the trigger
event.
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"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXTernal:SYNChronize:OUTPut
on page 97

Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
● The other path
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:DELay on page 99
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:DELay on page 97

Trigger Inhibit
Available on external triggering or on internal triggering via the second path.

Sets the duration for inhibiting a new trigger event subsequent to triggering.

In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified duration.

For two-path instruments, the trigger inhibit can be set separately for each of the two
paths.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:INHibit
on page 99
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:INHibit on page 97

Trigger/Marker/Clock Settings



TD-SCDMA User InterfaceTD-SCDMA, incl TD-SCDMA enhanced features

34Operating Manual 1171.5260.12 ─ 16

4.4.2 Marker Mode

The marker output signal for synchronizing external instruments is configured in the
marker settings section "Marker Mode".

The R&S SMBV supports only two markers.

Marker Mode
Selects a marker signal for the associated "MARKER" output.

"Radio Frame" A marker signal is generated every 10 ms (traffic channel frame
clock).

"Chip
Sequence
Period (ARB)"

A marker signal is generated at the beginning of every arbitrary wave-
form sequence (depending on the set sequence length). The marker
signal is generated regardless of whether or not an ARB component
is actually used.

"System
Frame Number
(SFN) Restart"

A marker signal is generated at the start of every SFN period (every
4096 frames).

"On/Off Ratio" A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples and are set in an input field which opens when ON/OFF ratio
is selected.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:ONTime on page 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:OFFTime on page 101

"User Period" A marker signal is generated at the beginning of every user-defined
period. The period is defined in "Period."

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:PERiod on page 102

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:MODE on page 101

4.4.3 Marker Delay

The delay of the signals on the MARKER outputs is set in the"Marker Delay" section.

The R&S SMBV supports only two markers.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
signal.
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If the setting "Fix marker delay to dynamic range" is enabled, the setting range is
restricted to the dynamic range. In this range, the delay of the marker signals can be
set without restarting the marker and signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay on page 100

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set
without restarting the marker and signal.

The delay can be defined by moving the setting mark.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MINimum?
on page 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MAXimum?
on page 101

Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range, the delay
can be set without restarting the marker and signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut:DELay:FIXed on page 100

4.4.4 Clock Settings

The Clock Settings is used to set the clock source and a delay if required.

Sync. Mode
(for R&S SMBV only)

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.
Avoid unnecessary cable length and branching points.

"None" The instrument is working in stand-alone mode.

"Sync. Master" The instrument provides all connected instrument with its synchroni-
sation (including the trigger signal) and reference clock signal.

"Sync. Slave" The instrument receives the synchronisation and reference clock sig-
nal from another instrument working in a master mode.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:MODE on page 103
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Set Synchronization Settings
(for R&S SMBV only)

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, selected with the parameter "Synchronization Mode".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:EXECute on page 103

Clock Source
Selects the clock source.

"Internal" The internal clock reference is used to generate the symbol clock.

"External" The external clock reference is fed in as the symbol clock or multiple
thereof via the CLOCK connector.
The symbol rate must be correctly set to an accuracy of +/-2 % (see
data sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".
In the case of two-path instruments this selection applies to path A.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SOURce on page 103

Clock Mode
Selects the type of externally supplied clock.

"Chip" A chip clock is supplied via the CLOCK connector.

"Multiple Chip" A multiple of the chip clock is supplied via the CLOCK connector. The
chip clock is derived internally from this. The value range is 1 to 64.
The Chip Clock Multiplier field provided allows the multiplication fac-
tor to be entered.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLOCk:MODE on page 102

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:CLOCk:MULTiplier on page 102

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

4.4.5 Global Settings

The buttons in this section lead to dialogs for general trigger, clock and mapping set-
tings.
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Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

The parameters in this dialog affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.

User Marker / AUX I/O Settings
Calls the "User Marker AUX I/O Settings" dialog, used to map the connector on the
rear of the instruments.

See also "User Marker / AUX I/O Settings" in the Operating Manual.

4.5 Predefined Settings

► To access this dialog select "TD-SCDMA > Predefined Settings".

The channel table of cell 1 is filled (preset) with the set parameters.

The settings provided in this dialog depend on the link direction and apply only to
cell1.

With the "Predefined Settings" function, it is possible to create highly complex scenar-
ios with just a few keystrokes. This function is of use if, say, just the envelope of the
signal is of interest.

Use PCCPCH (Downlink Slot 0, code 0+1)
(This feature is available in the downlink only.)

Selects, if P-CCPCH is used in the scenario or not.

If P-CCPCH is used, both P-CCPCHs are activated in slot 0 with spreading code 0+1.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:PPARameter:PCCPch:STATe on page 105

Spreading Factor Dedicated Channels
Selects the spreading factor for the DPCHs.

The available spreading factors depend on the link direction.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:SFACtor
on page 105

Number of Dedicated Channels
Sets the number of activated DPCHs.

The minimum number is 1 and the maximum number depends on the spreading factor:

Max. No. DPCH = 3 x "Spreading Factor"

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:COUNt on page 104

Crest Factor
Selects the desired range for the crest factor scenario.

The crest factor of the signal is kept in the desired range by varying the distribution of
the channels inside one slot and in between several slots.

"Minimum" The crest factor is minimized. The channels are distributed uniformly
over the slots and over the code domain of the individual slot.

"Average" An average crest factor is set. The channels are distributed uniformly
over the slots and successively in the code domain of the individual
slot.

"Worst" The crest factor is set to an unfavorable value (i.e. maximum). The
channels are distributed in clusters over the slots and successively in
the code domain of the individual slot.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:CRESt on page 104

Accept
Presets the channel table of cell 1 with the parameters defined in the "Predefined Set-
tings" dialog.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:EXECute on page 105

4.6 Cell Configuration

The "Cell" dialog provides the parameters for configuring general cell settings, and
specific slot-related settings.

The "Cell.." configuration dialog is called by selecting "Cell 1... Cell 4" in the "TD-
SCDMA" dialog. Cells can be configured independently of one another. Cell 1 also
includes real time channels.
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4.6.1 Common Settings

The upper section contains the common settings required for configuring the cell.

State
Activates or deactivates the selected cell.

The number of the selected cell is displayed in the dialog header.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:STATe on page 109

Use (Scrambling Code)
Activates or deactivates the scrambling code.

The scrambling code is deactivated, for example, for test purposes.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe:STATe on page 108

Scrambling Code
Sets the scrambling code. The scrambling code identifies the cell and is the starting
value of the scrambling code generator.

The scrambling code is used for transmitter-dependent scrambling of the chip
sequence. The value range is 0 to 127.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe on page 108

Basic Midamble Code ID
Displays the basic midamble code ID of the cell.

The basic midamble code ID is derived from the scrambling code.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:MCODe? on page 107

DwPTS Mode/ UpPTS Mode
Selects whether to use the pilot timeslot and its power or not. In case of "Auto" and
"On", the DwPTS/UpPTS is used. This is indicated in the "Select Slot in Subframe to
Configure" graph.

For details regarding the DwPTS/UpPTS, see Chapter 3.2, "DwPTS and UpPTS",
on page 12.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:MODE on page 106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:STATe? on page 107
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:MODE on page 106
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:STATe? on page 107

DwPTS Power/ UpPTS Power
Sets the power of the downlink/uplink pilot timeslot.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:MODE on page 106[:
SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:POWer on page 106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:POWer on page 106

SYNC-DL Code
Displays the SYNC-DL code.

The SYNC-DL code is transmitted in the DwPTS (downlink pilot timeslot). It is used by
the user equipment to synchronize to the base station.

The SYNC-DL code is derived from the scrambling code and the basic midamble code
ID.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SDCode? on page 108

Phase Rotation
Selects the phase rotation for the downlink pilots.

"Auto" Sets the default phase rotation sequence according to the presence
of the P-CCPCH.

"S1" There is a P-CCPCH in the next four subframes.

"S2" There is no P-CCPCH in the next four subframes.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:PROTation on page 107

SYNC-UL Code
Sets the SYNC-UL code.

The SYNC-UL code is transmitted in the UpPTS. It is used by the base station to syn-
chronize to the user equipment.

The SYNC-UL code is derived from the scrambling code and the basic midamble code
ID.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SUCode on page 109

Number of Users
Selects the total number of users of the cell. The number of users influences the actual
midamble sequence transmitted in the burst.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:USERs on page 109

Time Delay
(This feature is available for cell 2, 3, and 4 only)

Enters the time delay of the signal of the selected cell compared to the signal of cell 1.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:TDELay on page 109

4.6.2 Slots

In the lower section of the dialog, the slots are selected for configuration.

Enhanced Channels…
(available for cell1 only)

Accesses the dialog for setting enhanced channel configurations, see Chapter 4.7,
"Enhanced Channels Settings", on page 42.

Remote command: 
n.a.

Switching Point
Sets the switching point between the uplink slots and the downlink slots in the frame.

Slot 0 is always allocated to the downlink, Slot 1 is always allocated to the uplink.

In the "Select Slot in Subframe to Configure" section, the switching point is indicated by
a red bar. The slots to the left of the red bar are generated for link direction downlink,
to the right of the red bar for link direction uplink. Only the slots for one link direction
are active at a time, the slots of the other link direction are inactive.

The DwPTs is always active in downlink mode. The UpPTS is only active if PRACH is
selected for the uplink slots.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SPOint on page 108

Select Slot in Subframe to Configure
Displays the slots of the cell.

Active slots are highlighted blue (downlink) and green (uplink). Select a slot in the sub-
frame to access the dialog for configuring the channels of the selected slot, see Chap-
ter 4.9, "Slot Configuration", on page 64.

Remote command: 
n.a.

Slot Icon
Activates or deactivates the slot in the subframe.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:STATe
on page 135

GP (Guard Period)
The base station sends 16 chips of GP in each subframe and is inserted between the
DwPTS and UpPTS in each subframe. The GP is used to avoid the multipath interfer-
ence.

Remote command: 
n.a.

4.7 Enhanced Channels Settings

The "Enhanced Channels Settings" dialog is called in the "Cell Configuration" dialog
with button "Enhanced Channels…".

"This dialog is only available for Cell 1".

The layout of the "Enhanced Channels Settings" dialog depends on the "Link Direc-
tion". For "Downlink / Forward", the broadcast channels (BCH) section is provided. All
other sections are offered for both link directions.

The "Broadcast Channels (BCH)" section is where the enhanced state of the channels
can be activated. The detailed "Transport Channel" settings can be revealed with the
"Show Details >>>" button and hidden with the "<<<Hide Details" button.
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The "Dedicated Channels (DCH)" section is where the enhanced state of the channel
can be activated and settings can be made. The detailed "Transport Channel" settings
can be revealed with the "Show Details >>>" button and hidden with the "<<<
Hide Details" button.

The "Bit Error Insertion" section is where the bit error simulation is configured and acti-
vated.

The "Block Error Insertion" section is where the block error simulation is configured
and activated.
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4.7.1 Broadcast Channels (BCH) Common Settings

The "Broadcast Channels (BCH)" section is where the enhanced state of the channel
can be activated. This section is only available for "Downlink / Forward" transmission
direction.

State (BCH)
Activates or deactivates P-CCPCH 1/2 channel coding.

When activated, Slot 0 is active with P-CCPCH 1 and 2 switched on. The data source
is fixed to BCH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:STATe on page 124

Coding Type (BCH)
Displays the coding scheme.

The coding scheme of P-CCPCH (BCH) is specified in the standard. The channel is
generated automatically with the counting system frame number (SFN). The system
information after the SFN field is provided by the selected data source.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:TYPE? on page 125

Show Details…
Reveals the detailed settings options (see Chapter 4.7.2, "Broadcast Channels (BCH)
Details Settings", on page 45). Once the details are revealed, the labeling on the but-
ton changes to "<<<Hide Details". Clicking the button hides the detailed settings
options.

Remote command: 
n.a.

Mapping On Physical Channels: BCH mapped to <Slot> 0, P-CCPCH1/2
Displays the slots of Cell 1 used to transmit the broadcast channels. For BCH, Slot 0 is
always used.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SLOTstate<ch0>?
on page 124
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Spreading Code Selection (BCH)
Selects if the spreading code of the channels is set automatically or manually. For
BCH, the spreading code is always set to "Auto" as the spreading code for the P-
CCPCH is defined by the standard.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SCSMode?
on page 124

4.7.2 Broadcast Channels (BCH) Details Settings

Provided are the following settings:

Slot Format
Displays the slot format of the selected channel.

A slot format defines the complete structure of a slot made of data and control fields.
The slot format depends on the coding type selected.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SFORmat?
on page 124

Data Bits Per Frame (10 ms)
Displays the data bits in the DPDCH component of the DPCH frame at physical level.
The value depends on the slot format.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:BPFRame?
on page 120

Transport Channel
In the "Transport Channel " section, the transport channels (TCHs) can be configured.
For more information, refer to Chapter 4.7.5, "Transport Channel", on page 49.

4.7.3 Dedicated Channels (DCH) Common Settings

In the "Dedicated Channels (DCH)" section, the enhanced state of the channel can be
activated and enhanced channel settings can be made.

State (DCH)
Activates or deactivates DCH channel coding.

When the state is set to On, it activates the slots selected in the "Mapping On…" graph
below. The number and configuration of the DPCHs is defined by the selected coding
type. State and slot format of the channels are preset. The data source is fixed to DCH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:STATe
on page 119
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Coding Type
Selects the channel coding.

The current TD-SCDMA specification defines four reference measurement channel
(RMC) in the uplink. There are five measurement channel coding types in the downlink,
which differ in the input data bit rate to be processed.

Additionally, special RMCs are defined for HSDPA, HSUPA, HS-SICH and PLCCH.

Select one of the predefined downlink RMCs to preconfigure the settings for UE tests
according to 3GPP TS25.102, annex A.2.

Select one of the predefined uplink RMCs to preconfigure the settings for BS tests
according to 3GPP TS25.142, annex A.

The selected coding type defines the number of slots selected in section "Mapping On
Physical Channels: Select Slots To Use".

"RMC 12.2
kbps"

Downlink/uplink 12.2 kbps measurement channel.

Note: If RMC12K2, RMC64K, RMC144K, or RMC384K are selected
for the uplink, they are automatically converted to UP_RMCxxx.

"RMC 64 kbps"
Downlink/uplink 64 kbps measurement channel

"RMC 144 kbps"
Downlink/uplink 144 kbps measurement channel

"RMC 384 kbps"
Downlink/uplink 384 kbps measurement channel

"RMC 2048 kbps"
Downlink 2048 kbps measurement channel

"RMC PLCCH" Downlink RMC PLCCH channel (see RMC PLCCH Channel Settings)

"HSDPA" (downlink only)
HSDPA reference measurement channel (see Chapter 4.8, "HSDPA/
HSUPA Settings", on page 55).

"RMC HS-SICH"
Uplink RMC for transport channel HS-SICH (seeChapter 4.7.7, "RMC
HS-SICH Channel Settings", on page 53 )

"HSUPA" (uplink only)
HSUPA reference measurement channel (see Chapter 4.8, "HSDPA/
HSUPA Settings", on page 55).

"User" The channel settings are user-definable

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TYPE on page 120

Resource Units On Physical Layer
Displays the resource units on the physical layer needed to generate the selected
channel.

The table below gives an overview of the used resource units (RU) depending on the
selected Coding Type. The used "Number of Time Slots" and "Number of Channels"
is also displayed by the corresponding parameters.
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RMC Resources units allo-
cated

Description Transport
channels

 Downlink   

RMC 12.2 Kbps 1TS (2*SF16) =
2RU/5ms

1 slot with 2 code channels using
spreading factor 16

1DTCH +
1DCCH

RMC 64 Kbps 1TS (8*SF16) =
8RU/5ms

1 slot with 8 code channels using
spreading factor 16

1DTCH +
1DCCH

RMC 144 Kbps 2TS (8*SF16) =
16RU/5ms

2 slots with 8 code channels using
spreading factor 16

1DTCH +
1DCCH

RMC 384 Kbps 4TS (10*SF16) =
40RU/5ms

4 slots with 10 code channels using
spreading factor 16

1DTCH +
1DCCH

RMC 2048 kbps 5TS (1*SF1) =
80RU/5ms (8PSK)

5 slots with 1 code channel using
spreading factor 1

1DTCH +
1DCCH

RMC-PLCCH 1TS (1*SF16) =
1RU/5ms (QPSK)

1 slot with 1 code channel using
spreading factor 16

1DTCH

 Uplink   

RMC 12.2 Kbps 1TS (1*SF8) = 2RU/5ms 1 slot with 1 code channel using
spreading factor 8

1DTCH +
1DCCH

RMC 64 Kbps 1TS (1*SF2) = 8RU/5ms 1 slot with 1 code channel using
spreading factor 2

1DTCH +
1DCCH

RMC 144 Kbps 2TS (1*SF2) =
16RU/5ms

2 slots with 1 code channel using
spreading factor 2

1DTCH +
1DCCH

RMC 384 Kbps 4TS (1*SF2 + 1*SF8) =
40RU/5ms

4 slots with 2 code channel using
spreading factor 2 and 8

1DTCH +
1DCCH

RMC HS-SICH 1TS (1*SF16) =
1RU/5ms

1 slot with 1 code channel using
spreading factor 16

 

See "RMC Configuration" on page 56 and "E-DCH Fixed Reference Channel (FRC)"
on page 57 for an overview of the used resources units in HSDPA and HSUPA mode
respectively.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:RUPLayer?
on page 118

Show Details…
Reveals the detailed settings options (see Chapter 4.7.4, "Dedicated Channels (DCH)
Details Settings", on page 48). Once the details are revealed, the labeling on the but-
ton changes to "<<<Hide Details". Clicking the button hides the detailed settings
options.

Remote command: 
n.a.

Mapping On Physical Channels: Select Slots To Use
Displays the slots of Cell 1. The slots used to transmit the transport channel are high-
lighted.
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The number of slots is determined by the selected coding type. If a slot is deactivated,
another slot is activated automatically to keep the number of activated slots
unchanged.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SLOTstate<ch>
on page 119

Spreading Code Selection for Enhanced Channels
Selects the spreading code selection mode for the used transport channels.

"User" The spreading codes can be set manually.

"Auto" The spreading codes are distributed evenly over the slot domains in
order to ensure the minimum crest factor.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SCSMode
on page 119

4.7.4 Dedicated Channels (DCH) Details Settings

Provided are the following settings:

Number of Timeslots (DCH)
Sets the number of timeslots to be used.

The initial value is preset according to the selected Coding Type.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TSCount
on page 120

Number of Channels (DCH)
Sets the number of channels to be used.

The initial value is preset according to the selected Coding Type.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:CCOunt
on page 114

Slot Format
Displays the slot format of the selected channel.

A slot format defines the complete structure of a slot made of data and control fields.
The slot format depends on the coding type selected.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SFORmat?
on page 119

Data Bits Per Frame (10 ms)
Displays the data bits in the DPDCH component of the DPCH frame at physical level.
The value depends on the slot format.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BPFRame?
on page 114

Transport Channel
In the "Transport Channel " section, the transport channels (TCHs) can be configured.
For more information, refer to Chapter 4.7.5, "Transport Channel", on page 49.

4.7.5 Transport Channel

In the "Transport Channel " section, the transport channels (TCHs) can be configured.

The most important parameters of the TCH are displayed (transport block size and
data source). The associated parameters shown in the section below depend on which
TCH is selected. A wide arrow beneath the block indicates which TCH is selected.

DTCH On/DCCH On
Displays the transport channel state.

Note: For BCH, only the DTCH component is active.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
STATe on page 117

Data Source
Selects the data source for the transport channel.
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The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA
on page 121
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA on page 115
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:DSELect
on page 121
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA:DSELect on page 116
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:PATTern
on page 122
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA:PATTern on page 116

Transport Time Interval
Displays the number of frames into which a TCH is divided. This setting also defines
the interleaver depth.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TTINterval?
on page 123
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TTINterval on page 118

Transport Blocks
Displays the number of transport blocks for the TCH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBCount?
on page 123
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TBCount on page 118
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Transport Block Size
Displays the size of the transport block at the channel coding input.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBSize?
on page 123
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TBSize on page 118

Size Of CRC
Displays the type (length) of the CRC.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:CRCSize?
on page 121
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
CRCSize on page 115

Rate Matching Attribute
Displays the rate matching.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:RMATtribute?
on page 122
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
RMATtribute on page 117

Error Protection
Displays the error protection.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:EPRotection?
on page 122
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
EPRotection on page 116

Interleaver 1 State
Activates or deactivates the channel coding interleaver state 1 of the transport channel.
Interleaver state 1 can be set independently in each TCH. Activation does not change
the symbol rate.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:IONE
on page 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
IONE on page 117

Interleaver 2 State
Activates or deactivates the channel coding interleaver state 2 off all the transport
channels. Interleaver state 2 can only be set for all the TCHs together. Activation does
not change the symbol rate.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:ITWO
on page 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
ITWO on page 117

4.7.6 RMC PLCCH Channel Settings

This dialog comprises the detailed settings required for DCH configuration of the RMC
PLCCH channel. The settings are provided for downlink transmission direction and
"Coding Type > RMC PLCCH".

Transmission Time Interval (TTI) – RMC PLCCH
Displays the transmission time interval.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TTINterval?
on page 111

Number of Sync Shift&TPC Information Bits
Displays the number of information bits used for sync shift and TPC. The RMC PLCCH
doe not contains data bits.

Remote command: 
n.a.

Sync Shift Pattern
Sets the sync shift pattern. The pattern length is 21 bits.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:SSPattern
on page 111

TPC Pattern
Sets the TPC pattern. The pattern length is 21 bits.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TPCPattern
on page 111

Repetition Encoder
Displays the state of the repetition encoder.

Remote command: 
n.a.

4.7.7 RMC HS-SICH Channel Settings

This dialog comprises the detailed settings required for DCH configuration of the RMC
HS-SICH channel. These settings are provided for uplink transmission direction and
"Coding Type > RMC HS-SICH".

Transmission Time Interval (TTI) – RMC HS-SICH
Displays the transmission time interval.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:TTINterval?
on page 112
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CQI Modulation
Sets the CQI modulation.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:
MODulation on page 112

CQI Value
Sets the CQI value.

With the CQI (Channel quality indicator),the user equipment informs the base station
about the received quality of downlink HS-PDSCH. Thus the base station can adapt
the modulation and coding scheme to improve the signal quality.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:VALue
on page 112

ACK/NAK Pattern
Sets the ACK/NACK pattern. The pattern has a maximal length of 36 bits; a "1" corre-
sponds to ACK, a "0" to NAK.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:ANPattern
on page 112

4.7.8 Bit Error Insertion

In the "Bit Error Insertion" section, the bit error simulation is configured and activated.

State (Bit Error)
Activates or deactivates bit error generation.

Bit errors are inserted into the data fields of the enhanced channels. If channel coding
is active, it is possible to select the layer in which the errors are inserted (physical or
transport layer).

When the data source is read out, individual bits are inverted at random points in the
data bitstream at the specified error rate in order to simulate an invalid signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:STATe
on page 113

Bit Error Rate
Enters the bit error rate.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:RATE
on page 113

Insert Errors On
Selects the layer in the coding process at which bit errors are inserted.
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"Transport Layer"
Bit errors are inserted in the transport layer.
This selection is only available if channel coding is active.

"Physical Layer"
Bit errors are inserted in the physical layer.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:LAYer
on page 113

4.7.9 Block Error Insertion

In the "Block Error Insertion" section, you can configure and activate the block error
simulation.

State (Block Error)
Activates or deactivates block error generation.

The CRC checksum is determined and then the last bit is inverted at the specified error
probability in order to simulate an invalid signal.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:STATe
on page 114

Block Error Rate
Enters the block error rate.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:RATE
on page 114

4.8 HSDPA/HSUPA Settings

The HSDPA settings are available only for downlink transmission and "Coding Type >
HSDPA".

The HSUPA settings are available only for uplink transmission and "Coding Type >
HSUPA".
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4.8.1 HSDPA Settings

Provided are the following settings:

RMC Configuration
(HSDPA only)

Enables a predefined set of RMC channels or fully configurable user mode.

Following combinations are possible:

RMC Config. Modulation Resources units allocated Description Transport
channels

H-RMC 0.5
Mbps

QPSK 2TS (10*SF16) = 20RU/5ms 2 slots with 10 code chan-
nels using spreading factor
16

1H-DTCH

H-RMC 1.1
Mbps

QPSK 2TS (10*SF16) = 20RU/5ms 2 slots with 10 code chan-
nels using spreading factor
16

1H-DTCH

 16QAM 2TS (12*SF16) = 24RU/5ms 2 slots with 12 code chan-
nels using spreading factor
16

1H-DTCH

H-RMC 1.6
Mbps

QPSK 3TS (10*SF16) = 30RU/5ms 3 slots with 10 code chan-
nels using spreading factor
16

1H-DTCH

 16QAM 3TS (12*SF16) = 36RU/5ms 3 slots with 12 code chan-
nels using spreading factor
16

1H-DTCH

H-RMC 2.2
Mbps

QPSK 4TS (10*SF16) = 40RU/5ms 4 slots with 10 code chan-
nels using spreading factor
16

1H-DTCH

 16QAM 4TS (12*SF16) = 48RU/5ms 4 slots with 12 code chan-
nels using spreading factor
16

1H-DTCH

H-RMC 2.8
Mbps

QPSK 5TS (10*SF16) = 50RU/5ms 5 slots with 10 code chan-
nels using spreading factor
16

1H-DTCH

 16QAM 5TS (12*SF16) = 50RU/5ms 5 slots with 12 code chan-
nels using spreading factor
16

1H-DTCH
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RMC Config. Modulation Resources units allocated Description Transport
channels

H-RMC
64QAM

64QAM (Cat-
egory 16UE)

3TS (14*SF16) = 42RU/5ms 3 slots with 14 code chan-
nels using spreading factor
16

1H-DTCH

 64QAM (Cat-
egory 19UE)

5TS (14*SF16) = 70RU/5ms 5 slots with 14 code chan-
nels using spreading factor
16

1H-DTCH

 64QAM (Cat-
egory 22UE)

5TS (14*SF16) = 70RU/5ms 5 slots with 14 code chan-
nels using spreading factor
16

1H-DTCH

User - - - -

Several parameters are automatically set, depending on the selected RMC.

However, it is also possible to change these parameters.

In this case, the value of the parameter "RMC Configuration" is automatically set to
User.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:RMC
on page 143

4.8.2 HSUPA Settings

Provided are the following settings:

E-DCH Fixed Reference Channel (FRC)
(HSUPA only)

Selects a predefined E-DCH fixed reference channel or fully configurable user mode.

Following combinations are possible:

FRC Modulation Resources units
allocated

Description Transport chan-
nels

1 QPSK 2TS(1*SF4)
=2RU/5ms

2 slots with 1 code channel using
spreading factor 4

1DTCH

2 QPSK 2TS(1*SF2)
=2RU/5ms

2 slots with 1 code channel using
spreading factor 2

1DTCH

3 16QAM 3TS(1*SF2)
=3RU/5ms

3 slots with 1 code channel using
spreading factor 2

1DTCH

4 16QAM 4TS(1*SF1)
=2RU/5ms

4 slots with 1 code channel using
spreading factor 1

1DTCH

User - - - -

Several settings are preconfigured according to the selected FRC.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:FRC on page 146
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4.8.3 HS-SCCH Settings (HSDPA)

This section describes the "HS-SCCH" settings.

HS-SCCH State
(HSDPA only)

Enables/disables the HS-SCCH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SCCH
on page 144

UEID (H-RNTI)
(HSDPA only)

Sets the UE identity which is the HS-DSCH Radio network identifier(H-RNTI) defined in
3GPP TS25.331, "Radio resource control (RRC); Protocol Specification".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:UEID
on page 145

4.8.4 Global Settings

This section describes the HSDPA/HSUPA global settings.

UE Category
Displays the UE category that is minimum required to receive the selected RMC or
FRC.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
UECategory? on page 153

Maximum Information Bit Throughput /kbps
Displays maximum information bits sent in each TTI before coding.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
MIBT? on page 150
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Number of HS-PDSCH/E-DCH Timeslots
Sets the number of timeslots.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TSCount on page 152

Number of HS-PDSCH/E-DCH Codes per TS
Sets the number of physical channels per timeslot.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
CTSCount on page 148

Spreading Factor (FRC)
(HSUPA only)

Selects the spreading factor for the FRC.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:SFACtor
on page 147

Number of E-UCCH per TTI
(HSUPA only)

Sets the number of E-UCCH channels per TTI.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:EUCTti
on page 145

Slot Format (HSDPA/HSUPA)
Displays the slot format of the selected channel.

A slot format defines the complete structure of a slot made of data and control fields.
The slot format depends on the coding type selected.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
SFORmat? on page 152

Transmission Time Interval (TTI)
Displays the transmission time interval (TTI).

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TTINterval? on page 153

4.8.5 Coding Configuration

This section describes the HSDPA/HSUPA settings, related to the coding.
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Data Source (HSDPA/HSUPA)
Selects the data source for the HSDPA/HSUPA channels.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA on page 148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA:PATTern on page 149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA:DSELect on page 149

Modulation (HSDPA/HSUPA)
Sets the modulation scheme for each HSDPA RMC or HSUPA FRC.

64QAM is not available for the HSUPA FRCs.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
MODulation on page 150

Number of Coded Bits Per TTI
Displays the number of bits after coding.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
NCBTti? on page 151
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Transport Block Size Table
(HSDPA only)

Sets the transport block size table, according to the specification 3GPP TS 25.321.

The values available depend on the selected modulation.

Modulation TBS Table  

 Downlink Uplink

QPSK category [1, 3]

category [4, 6]

category [7, 9]

category [10,12]

category [13, 15]

category [16, 18]

category [19, 21]

category [22, 24]

category [1, 2]

category [3, 6]

16QAM category [4, 6]

category [7, 9]

category [10,12]

category [13, 15]

category [16, 18]

category [19, 21]

category [22, 24]

category [1, 2]

category [3, 6]

64QAM category [16, 18]

category [19, 21]

category [22, 24]

-

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TBS:TABLe
on page 144

Transport Block Size Table 0
(HSUPA only)

Sets the transport block size table, according to the specification 3GPP TS 25.321,
annex BC.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:TBS:TABLe
on page 147

Transport Block Size Index
Selects the index for the corresponding table, as described in 3GPP TS 25.321.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TBS:INDex on page 152
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Information Bit Payload (Ninf)
Displays the payload of the information bit. i.e. transport block size. This value deter-
mines the number of transport layer bits sent in each TTI before coding.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
BPAYload? on page 147

Coding Rate (HSDPA/HSUPA)
Displays the resulting coding rate.

The coding rate is calculated as a relation between the Information Bit Payload
and "Number of Coded Bits per TTI".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
CRATe? on page 148

Virtual IR Buffer Size (Per HARQ process)
(HSDPA only)

Sets the size of the virtual IR buffer.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:VIBSize
on page 145

4.8.6 Signal Structure

This section describes the HSDPA settings, necessary to configure the signal struc-
ture.

Inter TTI Distance
(HSDPA only)

Sets the inter-TTI distance. This is the distance between two packets in HSDPA packet
mode and determines whether data is sent each TTI or there is a DTX transmission in
some of the TTIs.

An "Inter TTI Distance" of 1 means continuous generation.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TTIDistance
on page 145

Number of HARQ Processes
Sets the number of HARQ processes. This value determines the distribution of the
payload in the subframes and depends on the "Inter TTI Distance".
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A minimum of three HARQ Processes are required to achieve continuous data trans-
mission.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
HARQ:LENGth on page 149

Signaling Pattern
Displays the distribution of packets over time. The "Signaling Pattern" displays a
HARQ-Process cycle and is a sequence of HARQ-IDs and "-". An HARQ-ID indicates a
packet, a "-" indicates no packet (see figure). The signaling pattern is cyclically repea-
ted.

Long signaling patterns with regular repeating groups of HARQ-ID and "-" are not dis-
played completely. The signaling pattern is shortened and ". . ." is displayed but the
scheduling is performed according to the selected "Inter TTI Distance". Long signaling
patterns with irregularity in the HARQ-ID and "-" groups are displayed completely.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SPATtern?
on page 144

4.8.7 HARQ Setup

This section describes the HSDPA/HSUPA Hybrid-ARQ settings.

HARQ Mode
Sets the HARQ simulation mode.

"Constant
ACK"

New data is used for each new TTI. This mode is used to simulate
maximum throughput transmission.

"Constant
NACK"

Enables NACK simulation, i.e. depending on the sequence selected
with parameter "Redundancy Version Sequence" packets are retrans-
mitted. This mode is used for testing with varying redundancy ver-
sion.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
HARQ:MODE on page 150

Redundancy Version Parameter
(for "HARQ Mode > Constant ACK")

Enters the redundancy version parameter.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
RVParameter on page 151

Redundancy Version Sequence
(for "HARQ Mode > Constant NACK")

Sets the retransmission sequence.

The sequence has a length of maximum 30 values. The sequence length determines
the maximum number of retransmissions. New data is retrieved from the data source
after reaching the end of the sequence.

For HSUPA, this parameter is read-only.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
RVSequence on page 151

Retransmission Sequence Number
(for HSUPA and "HARQ Mode > Constant ACK")

Sets the retransmission sequence number.

The value is fixed to 0.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSNumber?
on page 146

Retransmission Sequence
(for HSUPA and "HARQ Mode > Constant NACK")

Sets the retransmission sequence.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSEQuence
on page 146

4.9 Slot Configuration

The "Slot Configuration" dialog is called by selecting the respective slot in the "Cell
Configuration" dialog. The most important part of the dialog is the channel table with
graphical display of the structure of the channel being edited.
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4.9.1 Common Settings

Provided are the following settings:

State
Activates or deactivates the selected slot. The index of the selected slot is displayed in
the dialog header.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:STATe
on page 135

Slot Mode
(This feature is available in the uplink only.)

Selects the slot mode.

"Dedicated" Selects the Dedicated mode. In this mode, the instrument generates
a signal with a dedicated physical control channel (DPCCH) and up to
six dedicated physical data channels (DPDCH). The signal is used for
voice and data transmission.

"PRACH" In this mode, the instrument generates a single physical random
access channel (PRACH). This channel is needed to set up the con-
nection between the mobile and the base station. To set the PRACH
parameters, see Chapter 4.11, "Slot Mode PRACH Settings",
on page 76.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:MODE on page 135

Code Domain…
Opens the code domain display to check the code domain visually.

The display is described in Chapter 4.12, "Code Domain", on page 80.

Remote command: 
n.a.

Channel Graph…
Opens the channel graph display to check the configured signal visually.
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The display is described in Chapter 4.13, "Channel Graph", on page 81.

Remote command: 
n.a.

4.9.2 Channel Table

The "Channel table" is located in the lower part of the "Cell../Slot../DL" configuration
dialog.

The channel table is where the individual channel parameters are set. The structure of
the channel currently being edited is displayed graphically in the table header.

The number of channels and the available channel types depend on the link direction.
In downlink, Channels 0 to 5 are assigned to the special channels, with the allocation
of the channels being fixed. In uplink, Channel 0 is assigned to a special channel, with
the allocation of the channel being fixed. It is possible to simulate the signal of a base
station that supports high-speed channels.

See Table 4-3 and Table 4-4 for overview of the supported channel types and their
sequence in the TD-SCDMA channel table.

Table 4-3: Supported channel types (Downlink)

Index Short form Name Function

0 P-CCPCH 1 Primary Common Control Phys.
Channel 1

Transfers the system frame number
(SFN) Timing reference for additional
downlink channels Contains the BCH
transport channel

1 P-CCPCH 2 Primary Common Control Phys.
Channel 2

Transfers the system frame number
(SFN) Timing reference for additional
downlink channels Contains the BCH
transport channel

2 S-CCPCH 1 Secondary Common Control Phys.
Channel

 

3 S-CCPCH 2 Secondary Common Control Phys.
Channel

 

4 FPACH Fast Physical Access Channel  

5 PDSCH Phys. Downlink Shared Channel  

6-21 DPCH QPSK Dedicated Phys. Channel Modulation
QPSK

Transfers the user data and the con-
trol information

 DPCH 8PSK Dedicated Phys. Channel Modulation
8PSK

 

 HS-SCCH 1 High-Speed Shared Control Channel
1

 

 HS-SCCH 2 High-Speed Shared Control Channel
2

 

 HS-PDSCH
(QPSK)

High-Speed Phys. Downlink Shared
Channel QPSK
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Index Short form Name Function

 HS-PDSCH
(16QAM)

High-Speed Phys. Downlink Shared
Channel 16 QAM

 

 HS-PDSCH
(64QAM)

High-Speed Phys. Downlink Shared
Channel 64QAM

 

 PLCCH Physical layer common control chan-
nel

 

 E-AGCH E-DCH Absolute Grant Channel  

 E-HICH E-DCH Hybrid ARQ Indicator Chan-
nel

 

Table 4-4: Supported channel types (Uplink)

Index Short form Name Function

0 PUSCH Phys. Uplink Shared Channel  

1-16 DPCH QPSK Dedicated Phys. Channel Modulation
QPSK

 

 DPCH 8PSK Dedicated Phys. Channel Modulation
8PSK

 

 HS-SICH High-Speed Shared Information
Channel

 

 E-PUCH (QPSK) E-DCH Uplink Physical Channel
(QPSK)

 

 E-PUCH
(16QAM)

E-DCH Uplink Physical Channel
(16QAM)

 

 E-RUCCH E-DCH Random Access Uplink Con-
trol Channel

 

Channel Number
Displays the consecutive channel numbers. The range depends on the selected trans-
mission direction.

All available channels are displayed, even those that are inactive. Each channel is acti-
vated/deactivated by the "State" button.

Remote command: 
n.a.

Channel Type
Selects the channel type.

In the uplink, the channel type is fixed for channel number 0.

In the downlink, the channel type is fixed for channel numbers 0 to 5.

For the remaining numbers, the choice lies between the relevant standard channels
and the high-speed channels (see Table 4-3 and Table 4-4).

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:TYPE on page 134
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Enhanced
Displays the enhanced state. If the enhanced state is set to on, the channel coding
cannot be changed.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:ENHanced? on page 132

Crt.User/Mid.Shift
Enters the value for the user and displays the midamble shift.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:USER on page 135

Slot Format
Enters the slot format for the selected channel.

The range of the values depends on the channel selected. For DPCH 8PSK channels,
for example, the value range for the slot formats is 0 to 24.

A slot format defines the complete structure of a slot made of data and control fields
and includes the symbol rate.

Parameters set via the slot format can subsequently be changed individually.

The structure of the channel currently selected is displayed in a graphic above the
channel table.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:SFORmat on page 134

Sprd. Fact.
Enters the spreading factor for the selected channel. The selection depends on the
channel type and interacts with the slot format.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:SFACtor on page 133

Sprd. Code
Enters the spreading code for the selected channel. The code channel is spread with
the set spreading code. The range of values for the spreading code depends on the
channel type and the spreading factor. Depending on the channel type, the range of
values can be limited.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:SCODe on page 133

Power/dB
Sets the channel power in dB.
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The power entered is relative to the powers outputs of the other channels. If "Adjust
Total Power to 0 dB" is executed (top level of the TD-SCDMA dialog), all the power
data is relative to 0 dB.

The value range is -80 dB to 0 dB.

Note: The maximum channel power of 0 dB applies to non-blanked channels (duty
cycle 100%). With blanked channels, the maximum value can be increased to values
greater than 0 dB.
Uset the parameter "Adjust Total Power" to increase the power to a maximum value of
10*Log10(1/duty_cycle)

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:POWer on page 133

Data
Selects data source.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DATA on page 128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DATA:DSELect on page 128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DATA:PATTern on page 128

DPCCH Settings
Accesses the dialog for configuring the control fields of the selected channel.

The selected slot format predetermines the setting of the control fields.

So a change is also made to the control fields by changing the slot format and vice
versa.

The dialog is described in Chapter 4.10, "DPCCH Settings", on page 70

Slot Configuration



TD-SCDMA User InterfaceTD-SCDMA, incl TD-SCDMA enhanced features

70Operating Manual 1171.5260.12 ─ 16

Remote command: 
n.a.

State
Activates or deactivates the channel.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:STATe on page 134

Dom. Conf.
Displays whether the channel has a code domain conflict with one of the overlying
channels (with lower channel number).

If there is a conflict, a red dot appears and the column is colored soft orange. If there is
no conflict, the column is colored soft blue.

The R&S Signal Generator helps to resolve code domain conflicts. You get the button
required for this purpose by clicking the table field in a subdialog.

The graphical display of the code domain assignment of active code channels can be
accessed with the "Code Domain" button (see Chapter 4.12, "Code Domain",
on page 80).

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:DCONflict?
on page 135

4.10 DPCCH Settings

The "Config DPCCH" dialog for configuring the fields of the dedicated physical control-
ler can be called in the channel table in column "DPCCH Settings" with the "Config..."
button.
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The selected slot format predetermines the setting of the parameters provided in the
dialog. Whenever the TFCI state and pilot length settings are changed, the slot format
is adjusted accordingly. Pilot Length and TFCI state can be selected for the S-CCPCH
channel.

4.10.1 Slot Structure and Slot Format

The upper section of the dialog displays the slot structure with the associated informa-
tion.

Slot Structure
Displays the slot structure.

The structure in the graph represents the currently selected slot format.

Remote command: 
n.a.

Slot Format
Displays the slot format.

The slot format display changes when the "Number of TFCI Bits" and the "Number of
Sync Shift & TPC Bits" are modified.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:SFORmat on page 134

Midamble Shift
Displays the midamble shift.

The midamble can be shifted in the range of 0 to 120 chips in increments of 8 chips.
Channels belonging to the same user equipment are characterized by the same mid-
amble shift.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:MSHift? on page 132

4.10.2 TFCI Settings

The "TFCI Settings" section is where the TFCI length and value are set.

Number of TFCI Bits
Selects the length of the TFCI field expressed in bits.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TFCI:LENGth on page 129

TFCI Value
Enters the value of the TFCI field. The value range is 0 to 1023.

The coded TFCI word is divided into four parts:

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TFCI:VALue on page 130

4.10.3 Sync Shift Settings

The "Sync Shift Settings" section is where the settings regarding the sync shift are set.
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Number of Sync Shift & TPC Bits
Selects the length of the sync shift and the length of the TPC field expressed in bits.
The available values depend on the slot format.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:SYNC:LENGth on page 129

Sync Shift Pattern
Enters the bit pattern for the sync shift. The maximum pattern length is 64 bits.

The following values are allowed:
● 0: decreases the sync shift
● 1: increases the sync shift
● -: the sync shift stays unchanged

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:SYNC:PATTern on page 129

Sync Shift Repetition M
Enters the value for the sync shift repetition. This value defines the spacing for the
sync shift which is used to transmit a new timing adjustment. M specifies the spacing in
subframes of 5 ms each.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:SYNC:REPetition on page 129

4.10.4 E-UCCH Settings

The "E-UCCH Settings" section is available for "Channel Type > E-PUCH QPSK
16QAM" in "Link Direction > Uplink / Reverse".

These settings are preconfigured and disabled, if an HSUPA coding type is enabled for
the corresponding channel.
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Number of E-UCCH Channels
Sets the number of the E-DCH Uplink Control Channels (E-UCCH).

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:CCOunt on page 126

Number of Phy. Chan. Bits per E-UCCH
Displays the number of physical channel bits per one E-UCCH.

The value is fixed to 32.

Remote command: 
n.a.

E-TFCI Value
Enters the value of the TFCI field.

If an HSUPA is enabled for the corresponding channel, the E-TFCI value is set to the
value configured for the parameter Transport Block Size Index.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:TFCI on page 127

Retransmission Sequence Number (E-UCCH)
Sets the retransmission sequence number.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:RSNumber on page 127

HARQ Process ID
Sets the HARQ process ID.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:HPID on page 127

4.10.5 TPC Settings

The "TPC Settings" section is where the TPC field is set. The selected "Link direction"
determines the available parameters.
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Number of Sync Shift & TPC Bits
Selects the length of the sync shift and the length of the TPC field expressed in bits.
The available values depend on the slot format.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:SYNC:LENGth on page 129

Number of TPC Bits Per E-UCCH
Displays the number of the TPC field bits of the E-UCCH channel type, i.e. in uplink
transmission direction.

Remote command: 
n.a.

TPC Source
Selects the data source for the TPC field of the DPCCH.

The following standard data sources are available:
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:DATA on page 130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:DATA:PATTern on page 131
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:DATA:DSELect on page 130

Read Out Mode
Defines TPC data usage.

The TPC bits are used to signal the increase or reduction in transmit power to the
called station. For all read out modes, 1 bit is taken from the data stream for the TPC
field for each slot. The bit is entered into the bitstream several times, depending on the
symbol rate. The difference between the modes lies in the usage of the TPC bits.

The different modes can be used to set a specific output power and then let the power
oscillate around this value. For example, if the power is the pattern 11111, the power
can be varied with "Single + alt. 01" and "Single + alt. 10". Thus, power measurements
can be carried out at quasi-constant power.

DPCCH Settings
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● "Continuous:"
The TPC bits are used cyclically.

● "Single + All 0"
The TPC bits are used once, and then the TPC sequence is continued with 0 bits.

● "Single + All 1"
The TPC bits are used once, and then the TPC sequence is continued with 1 bit.

● "Single + alt. 01"
The TPC bits are used once and then the TPC sequence is continued with 0 bits
and 1 bit alternately. Bits as appended in multiples, depending on the symbol rate,
for example, 00001111.

● "Single + alt. 10"
The TPC bits are used once and then the TPC sequence is continued with 1 bit
and 0 bits alternately. Bits as appended in multiples, depending on by the symbol
rate, for example, 11110000.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:
CHANnel<us0>:DPCCh:TPC:READ on page 131

4.11 Slot Mode PRACH Settings

For uplink transmission direction, the "TD-SCDMA-Cell/Slot../UL" dialog contains the
parameters required for configuring the (physical random access channel) PRACH and
the UpTS (uplink pilot timeslot ).

The PRACH settings dialog can be called by selecting slot mode "PRACH" in the "Slot
Configuration" dialog.

4.11.1 Common Settings

The upper section of the dialog comprises the common PRACH settings.
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Power Step
Enters the power by which the UpPTS is increased from repetition to repetition. The
power set under Power is the "target power", used during the last repetition of the pre-
amble.

Example: 
UpPTS Power = 0 dB
UpPTS repetition = 3
Power step = 3
Generated power sequence:

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:PSTep
on page 141

UpPTS Start
Enters the number of the subframe in which the first UpPTS has to be transmitted. The
value range is 0 to 10.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:STARt
on page 141

Distance UpPTS
Enters the value to vary the timing between UpPTS and RACH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:DISTance
on page 140

Sequence Length
Displays the value of the sequence length.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:SLENgth?
on page 142

4.11.2 UpPTS Settings

In this section, you can configure the UpPTS power and repetition.

Power
Enters the power of the UpPTS.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:POWer
on page 140
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:
PCORrection? on page 140

UpPTS Repetition
Enters the number of UpPTS repetitions before a PRACH burst happens.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:
REPetition on page 141

4.11.3 RACH Message Part Settings

This section comprises the RACH (random access channel) message part settings.

State (RACH Message Part)
Activates or deactivates the RACH (random access channel) message part.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:STATe
on page 139

Message Length
Selects the message length of the random access channel expressed in subframes.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:LENGth
on page 137

Slot Format (PRACH)
Displays the slot format of the PRACH. The slot format depends on the selected
spreading factor.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFORmat?
on page 139

Power (RACH Message Part)
Enters the power of the PRACH message part.

The value range is -80 dB to 0 dB.
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Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:POWer
on page 138
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:
PCORrection on page 138

Spreading Factor (PRACH)
Selects the spreading factor for the PRACH.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFACtor
on page 139

Spreading Code (PRACH)
Enters the spreading code for the PRACH. The code channel is spread with the set
spreading code. The range of values of the spreading code depends on the channel
type and the spreading factor.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SCODe
on page 138

Data Source (PRACH)
Selects data source for the PRACH.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also "Main Dialog > Data List Management".

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA
on page 136
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:
DSELect on page 136
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:
PATTern on page 137
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Current User (PRACH)
Enters the number of current users.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:USER
on page 139

Midamble Shift (PRACH)
Displays the value for the midamble shift.

Remote command: 
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:MSHift?
on page 137

4.12 Code Domain

The channelization codes are taken from a code tree of hierarchical structure (see Fig-
ure 4-3). The higher the spreading factor, the smaller the symbol rate and vice versa.
The product of the spreading factor and symbol rate is constant and always yields the
chip rate.

The outer branches of the tree (right-most position in the figure) indicate the channeli-
zation codes for the smallest symbol rate (and thus the highest spreading factor).
Channelization codes with smaller spreading factor are contained in the codes with
larger spreading factor in the same code branch. When using such competitive chan-
nelization codes at the same time, the signals of associated code channels are mixed
such that they can no longer be separated in the receiver. Orthogonality is then lost.

Figure 4-3: Code tree of channelization codes
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The domain of a certain channelization code is the outer branch range (with minimum
symbol rate and max. spreading factor). It is based on the channelization code
selected in the code tree. Using a spreading code means that its entire domain is used.

The "Code Domain" indicates the assigned code domain.

The channelization code is plotted at the X axis, the colored bars indicate coherent
code channels. The colors are assigned to the spreading factor, the allocation is shown
below the graph. The relative power can be taken from the height of the bar.

4.13 Channel Graph

The channel graph display shows the active code channels.
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The channel number is plotted on the X axis. The red bars represent the special chan-
nel (P-CCPCH1 to PDSCH in the downlink, P-CCPCH1 to PUSCH in the uplink), the
green bars the data channels (DPCH). The height of the bars shows the relative power
of the channel. The graph is calculated from the settings that have been made.

Channel Graph
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5 Remote-Control Commands
The following commands are required to perform signal generation with the TD-
SCDMA options in a remote environment. We assume that the R&S Signal Generator
has already been set up for remote operation in a network as described in the
R&S Signal Generator documentation. A knowledge about the remote control opera-
tion and the SCPI command syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S Signal Generator operating manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1]|2 available baseband signals

OUTPut<ch> 1 .. 4 available markers

R&S SMBV supports two markers

EXTernal<ch> 1|2 external trigger connectors

CELL<st> [1]|2|3|4 Cell

DTCH<ch> 1 to 7  

SLOT<ch0> [0] to 6 Slot number

CHANnel<us0> [0] to 21 Channel number

Placeholder <root>

For commands that read out or save files in the default directory, the default directory
is set using command MMEM:CDIRectory. The examples in this description use the
place holder <root> in the syntax of the command.
● D:\ - for selecting the internal hard disk of a Windows instrument
● E:\ - for selecting the memory stick which is inserted at the USB interface of a

Windows instrument
● /var/user/ - for selecting the internal flash card of a Linux instrument
● /usb/ - for selecting the memory stick which is inserted at the USB interface of a

Linux instrument.
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Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, accessing files in a particular directory, etc.
● Information on regular trigger, marker and clock signals as well as filter settings, if

appropriate.
● General instrument configuration, such as configuring networks and remote opera-

tion
● Using the common status registers

For a description of such tasks, see the R&S Signal Generator operating manual.

The following commands specific to the TD-SCDMA are described here:

● General Commands................................................................................................84
● Filter/Clipping/ARB Settings....................................................................................91
● Trigger Settings.......................................................................................................96
● Marker Settings.....................................................................................................100
● Clock Settings....................................................................................................... 102
● Predefined Settings...............................................................................................104
● Cell Settings..........................................................................................................106
● Enhanced Channels of Cell 1................................................................................110
● Channel Settings...................................................................................................125
● HSDPA/HSUPA Settings...................................................................................... 142

5.1 General Commands

[:SOURce<hw>]:BB:TDSCdma:COPY:SOURce..................................................................85
[:SOURce<hw>]:BB:TDSCdma:COPY:DESTination............................................................ 85
[:SOURce<hw>]:BB:TDSCdma:COPY:EXECute................................................................. 85
[:SOURce<hw>]:BB:TDSCdma:CRATe?............................................................................ 85
[:SOURce<hw>]:BB:TDSCdma:CRATe:VARiation...............................................................86
[:SOURce<hw>]:BB:TDSCdma:LINK..................................................................................86
[:SOURce<hw>]:BB:TDSCdma:POWer:ADJust...................................................................86
[:SOURce<hw>]:BB:TDSCdma:POWer[:TOTal]?.................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:BBONly................................................................. 87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:FDELay.................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:RDELay.................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:SHAPe.................................................................. 88
[:SOURce<hw>]:BB:TDSCdma:PRAMp:TIME.....................................................................88
[:SOURce<hw>]:BB:TDSCdma:PRESet............................................................................. 88
[:SOURce<hw>]:BB:TDSCdma:RESet............................................................................... 88
[:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog?.............................................................89
[:SOURce<hw>]:BB:TDSCdma:SETTing:LOAD.................................................................. 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe................................................................ 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe:FAST....................................................... 90
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[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel............................................................... 90
[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel:CATalog?................................................90
[:SOURce<hw>]:BB:TDSCdma:STATe...............................................................................90
[:SOURce<hw>]:BB:TDSCdma:VERSion?..........................................................................91
[:SOURce<hw>]:BB:TDSCdma:WAVeform:CREate.............................................................91

[:SOURce<hw>]:BB:TDSCdma:COPY:SOURce <Source>

Selects the cell whose settings are to be copied.

Parameters:
<Source> 1 | 2 | 3 | 4

Range: 1  to  4
*RST: 1 (Cell1)

Example: See [:SOURce<hw>]:BB:TDSCdma:COPY:DESTination
on page 85

Manual operation: See "Copy Cell..." on page 22

[:SOURce<hw>]:BB:TDSCdma:COPY:DESTination <Destination>

Selects the cell whose settings are to be overwritten.

Parameters:
<Destination> 1 | 2 | 3 | 4

Range: 1  to  4
*RST: 2 (Cell2)

Example: BB:TDSC:LINK DOWN
BB:TDSC:COPY:SOUR 1
BB:TDSC:COPY:DEST 4
BB:TDSC:COPY:EXEC

Manual operation: See "Copy Cell..." on page 22

[:SOURce<hw>]:BB:TDSCdma:COPY:EXECute

Starts the copy process. The dataset of the selected source cell is copied to the desti-
nation cell.

Example: See [:SOURce<hw>]:BB:TDSCdma:COPY:DESTination
on page 85

Usage: Event

Manual operation: See "Copy Cell..." on page 22

[:SOURce<hw>]:BB:TDSCdma:CRATe?

Queries the system chip rate.
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The output chip rate which determines the rate of the spread symbols as is used for
signal output can be set with the command SOUR:BB:TDSC:CRAT:VAR.

Return values: 
<CRate> R1M28

*RST: R1M28

Example: BB:TDSC:CRAT?
Response: R1M2
The system chip rate is 1.2288 Mcps.

Usage: Query only

Manual operation: See "Chip Rate" on page 19

[:SOURce<hw>]:BB:TDSCdma:CRATe:VARiation <Variation>

Sets the output chip rate.

The output chip rate changes the output clock and the modulation bandwidth, as well
as the synchronization signals that are output. It does not affect the calculated chip
sequence.

Parameters:
<Variation> float

Range: 400  to  5E6
Increment: 0.001
*RST: 1280000
Default unit: Hz (c/s)

Example: BB:TDSC:CRAT:VAR 4086001
sets the chip rate to 4.08 Mcps.

Manual operation: See "Chip Rate Variation" on page 24

[:SOURce<hw>]:BB:TDSCdma:LINK <Link>

Defines the transmission direction.

Parameters:
<Link> FORWard | DOWN | REVerse | UP

*RST: DOWN

Example: BB:TDSC:LINK DOWN
Manual operation: See "Link Direction" on page 20

[:SOURce<hw>]:BB:TDSCdma:POWer:ADJust

The command sets the power of the active channels in such a way that the total power
of the active channels is 0 dB. This will not change the power ratio among the individ-
ual channels.
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Example: BB:TDSC:POW:ADJ
the total power of the active channels is set to 0 dB, the power
ratio among the individual channels is unchanged.

Usage: Event

Manual operation: See "Adjust Total Power to 0dB" on page 22

[:SOURce<hw>]:BB:TDSCdma:POWer[:TOTal]?

Queries the total power of the active channels. After "Power Adjust", this power corre-
sponds to 0 dB.

Return values: 
<Total> float

Increment: 0.01

Example: BB:TDSC:POW:TOT?
queries the total power of the active channels.
Response: -22.5
the total power is -22.5 dB.

Usage: Query only

Manual operation: See "Total Power" on page 22

[:SOURce<hw>]:BB:TDSCdma:PRAMp:BBONly <BbOnly>

Activates or deactivates power ramping for the baseband signals.

Parameters:
<BbOnly> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:PRAM:BBON ON
Manual operation: See "In Baseband Only" on page 28

[:SOURce<hw>]:BB:TDSCdma:PRAMp:FDELay <FDelay>
[:SOURce<hw>]:BB:TDSCdma:PRAMp:RDELay <RDelay>

Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
delays the ramp and a negative value causes an advance.

Parameters:
<RDelay> integer

Range: -4  to  4
*RST: 2 (FDELay) / -2 (RDELay)

Example: BB:TDSC:PRAM:RDEL 8.0
Sets the offset in the rising edge of the envelope to 8.0 chips.

Manual operation: See "Rise Delay" on page 28
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[:SOURce<hw>]:BB:TDSCdma:PRAMp:SHAPe <Shape>

Selects the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.

Parameters:
<Shape> LINear | COSine

*RST: COSine

Example: BB:TDSC:PRAM:SHAP LIN
Sets a linear shape.

Manual operation: See "Ramp Function" on page 28

[:SOURce<hw>]:BB:TDSCdma:PRAMp:TIME <Time>

Sets the power ramping rise time and fall time for a burst.

Parameters:
<Time> integer

Range: 0  to  4
*RST: 2

Example: BB:TDSC:PRAM:TIME 2.0
Manual operation: See "Ramp Time" on page 28

[:SOURce<hw>]:BB:TDSCdma:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:TDSCdma:STATe.

Example: SOURce1:BB:TDSCdma:PRESet
Usage: Event

Manual operation: See "Set To Default" on page 17

[:SOURce<hw>]:BB:TDSCdma:RESet

Resets all cells to the predefined settings. The reset applies to the selected link direc-
tion.

An overview is provided by table in Set To Default.

Example: BB:TDSC:RES
resets all the cells to the predefined settings.

Usage: Event

Manual operation: See "Reset All Cells" on page 21
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[:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog?

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.tdscdma.

For general information on file handling in the default and in a specific directory, see
section "MMEMory Subsystem" in the R&S SMx/AMU operating manual.

Return values: 
<Catalog> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: MMEM:CDIR '<root>tdscdma'
SOURce1:BB:TDSCdma:SETTing:CATalog?
// Response: "up", "down"
SOURce1:BB:TDSCdma:SETTing:LOAD "up"
SOURce1:BB:TDSCdma:SETTing:STOR 'tdscdma_1'

Usage: Query only

Manual operation: See "Save/Recall..." on page 17

[:SOURce<hw>]:BB:TDSCdma:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.tdscdma.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See [:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog?
on page 89

Usage: Setting only

Manual operation: See "Save/Recall..." on page 17

[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe <Filename>

Stores the current settings into the selected file; the file extension (*.tdscdma) is
assigned automatically.

Setting parameters: 
<Filename> string

Filename or complete file path

Example: See [:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog?
on page 89

Usage: Setting only

Manual operation: See "Save/Recall..." on page 17
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[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<Fast> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "Save/Recall..." on page 17

[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel <TModel>

Selects the file with the test models defined in the TD-SCDMA standard or a self-
defined test setup.

Parameters:
<TModel> string

Example: BB:TDSC:SETT:TMOD 'Test_Mode_ACLR'
calls the specified test model.

Manual operation: See "Test Setups/Models" on page 23

[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel:CATalog?

Queries the file with the test models defined in the TD-SCDMA standard or a self-
defined test setup.

Return values: 
<Catalog> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: MMEM:CDIR '<root>tdscdma'
SOURce1:BB:TDSCdma:SETTing:TMODel:CATalog?
// Response: "tdscma_tm1", "tdscma_tm2"

Usage: Query only

[:SOURce<hw>]:BB:TDSCdma:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:TDSCdma:STATe ON
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Manual operation: See "State" on page 17

[:SOURce<hw>]:BB:TDSCdma:VERSion?

Queries the version of the TD-SCDMA standard underlying the definitions.

Return values: 
<Version> string

Example: BB:TDSC:VERS?
Response: Release C

Usage: Query only

Manual operation: See "TD-SCDMA Version" on page 19

[:SOURce<hw>]:BB:TDSCdma:WAVeform:CREate <Filename>

Stores the current settings as an ARB signal in a waveform file (*.wv).

For general information on file handling in the default and in a specific directory, see
section "MMEMory Subsystem" in the R&S SMx/AMU operating manual.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is assigned auto-
matically

Example: MMEM:CDIR '<root>wavefrom'
SOURce1:BB:TDSCdma:WAVeform:CREate "tdscdma"

Usage: Setting only

Manual operation: See "Generate Waveform File…" on page 19

5.2 Filter/Clipping/ARB Settings

[:SOURce<hw>]:BB:TDSCdma:CLIPping:LEVel..................................................................92
[:SOURce<hw>]:BB:TDSCdma:CLIPping:MODE.................................................................92
[:SOURce<hw>]:BB:TDSCdma:CLIPping:STATe................................................................ 92
[:SOURce<hw>]:BB:TDSCdma:FILTer:TYPE......................................................................92
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:APCO25................................................93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:COSine................................................. 93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:GAUSs..................................................93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASs...................................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASSEVM........................................... 94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:PGAuss.................................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:RCOSine...............................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:SPHase.................................................95
[:SOURce<hw>]:BB:TDSCdma:SLENgth............................................................................95
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[:SOURce<hw>]:BB:TDSCdma:CLIPping:LEVel <Level>

Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Parameters:
<Level> integer

Range: 1  to  100
*RST: 100
Default unit: PCT

Example: BB:TDSC:CLIP:LEV 80
BB:TDSC:CLIP:STAT ON

Manual operation: See "Clipping Level" on page 26

[:SOURce<hw>]:BB:TDSCdma:CLIPping:MODE <Mode>

Sets the method for level clipping.

Parameters:
<Mode> VECTor | SCALar

VECTor
The reference level is the amplitude.
SCALar
The reference level is the absolute maximum of the I and Q val-
ues.
*RST: VECTor

Example: BB:TDSC:CLIP:MODE VECT
Manual operation: See "Clipping Mode" on page 26

[:SOURce<hw>]:BB:TDSCdma:CLIPping:STATe <State>

Activates level clipping

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:CLIP:STAT ON
Manual operation: See "Clipping State" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:TYPE <Type>

Selects the filter type.
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Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: RCOSine

Example: BB:TDSC:FILT:TYPE RCOS
Manual operation: See "Filter" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:APCO25 <Apco25>

Sets the rolloff factor for filter type APCO25.

Parameters:
<Apco25> float

Range: 0.05  to  0.99
Increment: 0.01
*RST: 0.2

Example: BB:TDSC:FILT:PAR:APCO25 0.2
Manual operation: See "Rolloff Factor or BxT" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:COSine <Cosine>

Sets the rolloff factor for the cosine filter type.

Parameters:
<Cosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.35

Example: BB:TDSC:FILT:PAR:COS 0.35
Manual operation: See "Rolloff Factor or BxT" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:GAUSs <Gauss>

Sets the BxT for the gauss filter type.

Parameters:
<Gauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: BB:TDSC:FILT:PAR:GAUS 0.5
Manual operation: See "Rolloff Factor or BxT" on page 24
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[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASs <LPass>

Sets the cutoff frequency factor for the Lowpass (ACP opt) filter type.

Parameters:
<LPass> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:TDSC:FILT:PAR:LPAS 0.5
Manual operation: See "Cutoff Frequency Factor" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASSEVM <LPassEvm>

Sets the cutoff frequency factor for the Lowpass (EVM opt) filter type.

Parameters:
<LPassEvm> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: BB:TDSC:FILT:PAR:LPASSEVM 0.5
Manual operation: See "Cutoff Frequency Factor" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:PGAuss <PGauss>

Sets the BxT for the pure gauss filter type.

Parameters:
<PGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: BB:TDSC:FILT:PAR:GAUS 0.5
Manual operation: See "Rolloff Factor or BxT" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:RCOSine <RCosine>

Sets the rolloff factor for the root cosine filter type.

Parameters:
<RCosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.22

Example: BB:TDSC:FILT:PAR:RCOS 0.22
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Manual operation: See "Rolloff Factor or BxT" on page 24

[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:SPHase <SPhase>

Sets the BxT for the split phase filter type.

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: BB:TDSC:FILT:PAR:SPH 0.5
Manual operation: See "Rolloff Factor or BxT" on page 24

[:SOURce<hw>]:BB:TDSCdma:SLENgth <SLength>

Sets the sequence length of the arbitrary waveform component of the TD-SCDMA sig-
nal in the number of frames. This component is calculated in advance and output in the
arbitrary waveform generator. It is added to the realtime signal components.

Parameters:
<SLength> integer

Range: 1  to  5000
*RST: 1

Example: BB:TDSC:SLEN 10
Manual operation: See "Sequence Length ARB" on page 27
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5.3 Trigger Settings

Example: Trigger configuration
SOURce1:BB:TDSCdma:TRIGger:SOURce INTernal
SOURce1:BB:TDSCdma:TRIGger:SEQuence ARETrigger
SOURce1:BB:TDSCdma:STAT ON
SOURce1:BB:TDSCdma:TRIGger:EXECute
SOURce1:BB:TDSCdma:TRIGger:ARM:EXECute
SOURce1:BB:TDSCdma:TRIGger:RMODe?
// stopped
SOURce1:BB:TDSCdma:TRIGger:EXECute
SOURce1:BB:TDSCdma:TRIGger:RMODe?
// run

// SOURce1:BB:TDSCdma:TRIGger:SEQuence SING
// SOURce1:BB:TDSCdma:TRIGger:SLUNit SEQuence
// SOURce1:BB:TDSCdma:TRIGger:SLENgth 2

// SOURce1:BB:TDSCdma:TRIGger:SEQuence AAUT
// SOURce1:BB:TDSCdma:TRIGger:SOURce EXT
// SOURce1:BB:TDSCdma:TRIGger:EXTernal:SYNChronize:OUTPut 1
// SOURce1:BB:TDSCdma:TRIGger:EXTernal1:INHibit 100
// SOURce1:BB:TDSCdma:TRIGger:EXTernal1:DELay 10

[:SOURce<hw>]:BB:TDSCdma:TRIGger:ARM:EXECute......................................................96
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXECute.............................................................. 96
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXTernal:SYNChronize:OUTPut.............................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:DELay...............................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:INHibit...............................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:RMODe?..............................................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLENgth.............................................................. 98
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLUNit................................................................. 98
[:SOURce<hw>]:BB:TDSCdma:TRIGger:SOURce...............................................................98
[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:DELay.......................................... 99
[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:INHibit.......................................... 99
[:SOURce<hw>]:BB:TDSCdma[:TRIGger]:SEQuence..........................................................99

[:SOURce<hw>]:BB:TDSCdma:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.

Example: See Example "Trigger configuration" on page 96

Usage: Event

Manual operation: See "Arm" on page 20

[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXECute

Executes a trigger.
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Example: See Example "Trigger configuration" on page 96

Usage: Event

Manual operation: See "Execute Trigger" on page 20

[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXTernal:SYNChronize:OUTPut
<Output>

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

*RST: 1

Example: See Example "Trigger configuration" on page 96

Manual operation: See "Sync. Output to External Trigger" on page 31

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:DELay <Delay>

Specifies the trigger delay (expressed as a number of chips) for triggering by the trig-
ger signal from the second path.

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: BB:TDSC:TRIG:SOUR OBAS
BB:TDSC:TRIG:OBAS:DEL 50

Manual operation: See "Trigger Delay" on page 33

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:INHibit <Inhibit>

For triggering via the other path, specifies the duration by which a restart is inhibited.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:TDSC:TRIG:SOUR OBAS
BB:TDSC:TRIG:INH 200

Manual operation: See "Trigger Inhibit" on page 33

[:SOURce<hw>]:BB:TDSCdma:TRIGger:RMODe?

Queries the signal generation status.
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Return values: 
<RMode> STOP | RUN

Example: See Example "Trigger configuration" on page 96

Usage: Query only

Manual operation: See "Running/Stopped" on page 31

[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SINGle trigger mode.

Parameters:
<SLength> integer

Range: 1  to  max
*RST: 12800

Example: See Example "Trigger configuration" on page 96

Manual operation: See "Signal Duration" on page 30

[:SOURce<hw>]:BB:TDSCdma:TRIGger:SLUNit <SlUnit>

Defines the unit for the entry of the signal sequence length.

Parameters:
<SlUnit> FRAMe | CHIP | SEQuence

*RST: SEQuence

Example: See Example "Trigger configuration" on page 96

Manual operation: See "Signal Duration Unit" on page 30

[:SOURce<hw>]:BB:TDSCdma:TRIGger:SOURce <Source>

Selects the trigger source:
● INTernal: manual trigger or *TRG.
● EXTernal|BEXTernal: trigger signal on the TRIGGER 1/2 connector.
● OBASeband: trigger signal from the other path

Parameters:
<Source> INTernal|OBASeband|BEXTernal|EXTernal

*RST: INTernal

Example: SOURce1:BB:TDSCdma:TRIGger:SOURce EXTernal
Sets external triggering via the TRIGGER 1 connector.

Manual operation: See "Trigger Source" on page 31
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[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:DELay <Delay>

Specifies the trigger delay (expressed as a number of chips) for external triggering.

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: BB:TDSC:TRIG:SOUR EXT
BB:TDSC:TRIG:DEL 50

Manual operation: See "Trigger Delay" on page 33

[:SOURce<hw>]:BB:TDSCdma:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

Specifies the number of chips by which a restart is to be inhibited following a trigger
event. This command applies only in the case of external triggering.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:TDSC:TRIG:SOUR EXT1
BB:TDSC:TRIG:INH 200

Manual operation: See "Trigger Inhibit" on page 33

[:SOURce<hw>]:BB:TDSCdma[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode:
● AUTO = auto
● RETRigger = retrigger
● AAUTo = armed auto
● ARETrigger = armed retrigger
● SINGle = single

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Example "Trigger configuration" on page 96

Manual operation: See "Trigger Mode" on page 30
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5.4 Marker Settings

Example: Marker configuration
SOURce1:BB:TDSCdma:TRIGger:OUTPut1:MODE USER
SOURce1:BB:TDSCdma:TRIGger:OUTPut1:PERiod 12800

SOURce1:BB:TDSCdma:TRIGger:OUTPut1:MODE RAT
SOURce1:BB:TDSCdma:TRIGger:OUTPut1:ONTime 1
SOURce1:BB:TDSCdma:TRIGger:OUTPut1:OFFTime 1
// defines the on/off ratio

// Marker delay configuration
SOURce1:BB:TDSCdma:TRIGger:OUTPut:DELay:FIXed 1
// restricts the marker signal delay
SOURce1:BB:TDSCdma:TRIGger:OUTPut:DELay:MINimum?
// 0
SOURce1:BB:TDSCdma:TRIGger:OUTPut:DELay:MAXimum?
// 2000
SOURce1:BB:TDSCdma:TRIGger:OUTPut2:DELay 1600
// delays the marker signal output

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut:DELay:FIXed..........................................100
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay............................................100
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MINimum?........................... 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MAXimum?.......................... 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:MODE............................................101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:OFFTime........................................101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:ONTime..........................................101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:PERiod...........................................102

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut:DELay:FIXed <Fixed>

Restricts the marker delay setting range to the dynamic range.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Marker configuration" on page 100

Manual operation: See "Fix marker delay to current range" on page 35

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

 

Marker Settings



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

101Operating Manual 1171.5260.12 ─ 16

Parameters:
<Delay> float

Range: 0  to  2000
Increment: 0.001
*RST: 0

Example: See Example "Marker configuration" on page 100

Manual operation: See "Marker x Delay" on page 34

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MINimum?
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MAXimum?
Queries the min/max marker delay.

Return values: 
<Maximum> float

Example: See Example "Marker configuration" on page 100

Usage: Query only

Manual operation: See "Current Range without Recalculation" on page 35

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> RFRame | SFNR | CSPeriod | RATio | USER | FACTive |

TRIGger
RFRame = Radio Frame
SFNR = System Frame Number (SFN) Restart
CSPeriod = Chip Sequence Period (ARB)
RATio = On/Off Ratio
USER = User Period

TRIGger
A received internal or external trigger signal is output at the
marker connector.
*RST: RFRame

Example: See Example "Marker configuration" on page 100

Manual operation: See "Marker Mode" on page 34

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:OFFTime <OffTime>
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:ONTime <OnTime>

Sets the number of chips during which the marker output is on or off.
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Parameters:
<OnTime> integer

Range: 1  to  16777215
*RST: 1

Example: See Example "Marker configuration" on page 100

Manual operation: See "Marker Mode" on page 34

[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:PERiod <Period>

Sets the repetition rate for the signal at the marker outputs

Parameters:
<Period> integer

Range: 1  to  (2^32-1) chips
*RST: 12800

Example: See Example "Marker configuration" on page 100

Manual operation: See "Marker Mode" on page 34

5.5 Clock Settings

[:SOURce<hw>]:BB:TDSCdma:CLOCk:MODE................................................................. 102
[:SOURce<hw>]:BB:TDSCdma:CLOCk:MULTiplier............................................................102
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SOURce.............................................................. 103
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:EXECute.................................... 103
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:MODE........................................103

[:SOURce<hw>]:BB:TDSCdma:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Mode> CHIP | MCHip

*RST: CHIP

Example: SOURce1:BB:TDSCdma:CLOCk:MODE CHIP
Sets the type of externally supplied clock.

Manual operation: See "Clock Mode" on page 36

[:SOURce<hw>]:BB:TDSCdma:CLOCk:MULTiplier <Multiplier>

The command specifies the multiplier for clock type "Multiplied"
(:BB:TDSCdma:CLOCk:MODE MCHip) in the case of an external clock source.
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For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Multiplier> integer

Range: 1  to  64
*RST: 4

Example: SOURce1:BB:TDSCdma:CLOCk:SOURce EXTernal
Selects the external clock source.
SOURce1:BB:TDSCdma:CLOCk:MODE MCHip
SOURce1:BB:TDSCdma:CLOCk:MULTiplier 12

Manual operation: See "Clock Multiplier" on page 36

[:SOURce<hw>]:BB:TDSCdma:CLOCk:SOURce <Source>

Selects the clock source.

Parameters:
<Source> INTernal | EXTernal | AINTernal

INTernal
The internal clock reference is used.
EXTernal
External clock reference; only possible for path A
AINTernal
(in path B only)
The clock source of path A is used for path B.
*RST: INTernal

Example: BB:TDSC:CLOC:SOUR EXT
BB:TDSC:CLOC:MODE MCH
BB:TDSC:CLOC:MULT 12

Manual operation: See "Clock Source" on page 36

[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:EXECute

Adjusts the R&S SMBV settings according to the selected synchronization mode.

Example: SOURce:BB:TDSCdma:CLOCk:SYNChronization:MODE MASTer
SOURce:BB:TDSCdma:CLOCk:SYNChronization:EXECute

Usage: Event

Manual operation: See "Set Synchronization Settings" on page 36

[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:MODE <Mode>

If several R&S SMBVs are connected to generate precise synchronous signal, sets the
synchronization mode of each instrument.
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Parameters:
<Mode> NONE | MASTer | SLAVe

*RST: NONE

Example: See [:SOURce<hw>]:BB:TDSCdma:CLOCk:
SYNChronization:EXECute on page 103

Manual operation: See "Sync. Mode" on page 35

5.6 Predefined Settings

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:COUNt..............................104
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:CRESt.............................. 104
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:SFACtor............................105
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:EXECute..................................... 105
[:SOURce<hw>]:BB:TDSCdma:DOWN:PPARameter:PCCPch:STATe................................ 105

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:COUNt <Count>

Sets the number of activated DPCHs.

The maximum number depends on the spreading factor:

Max. No. DPCH = 3 x "Spreading Factor"

Parameters:
<Count> integer

Range: 1  to  48
*RST: 12

Example: BB:TDSC:DOWN:PPAR:DPCH:COUN 48
Manual operation: See "Number of Dedicated Channels" on page 38

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:CRESt <Crest>

Selects the desired range for the crest factor of the test scenario.
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Parameters:
<Crest> MINimum | AVERage | WORSt

MINimum
The crest factor is minimized.
The channelization codes are distributed uniformly over the code
domain. The timing offsets are increased by 3 per channel.
AVERage
An average crest factor is set.
The channelization codes are distributed uniformly over the code
domain. The timing offsets are all set to 0.
WORSt
The crest factor is set to an unfavorable value (i.e. maximum).
The channelization codes are assigned in ascending order. The
timing offsets are all set to 0.
*RST: MINimum

Example: BB:TDSC:DOWN:PPAR:DPCH:CRES WORS
Manual operation: See "Crest Factor" on page 38

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:SFACtor <SFactor>

Sets the spreading factor for the DPCHs.

Parameters:
<SFactor> 1 | 2 | 4 | 8 | 16

*RST: 16

Example: BB:TDSC:DOWN | UP:PPAR:DPCH:SFAC 16
Manual operation: See "Spreading Factor Dedicated Channels" on page 37

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:EXECute

Presets the channel table of cell 1 with the parameters defined by the PPARameter
commands. Scrambling Code 0 is automatically selected.

Example: BB:TDSC:DOWN:PPAR:EXEC
Usage: Event

Manual operation: See "Accept" on page 38

[:SOURce<hw>]:BB:TDSCdma:DOWN:PPARameter:PCCPch:STATe <State>

Defines, if P-CCPCH is used in the scenario or not.

If P-CCPCH is used, both P-CCPCHs are activated in slot 0 with spreading code 0+1.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1
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Example: BB:TDSC:DOWN:PPAR:PCCP:STAT ON
Manual operation: See "Use PCCPCH (Downlink Slot 0, code 0+1)" on page 37

5.7 Cell Settings

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:MODE............................................. 106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:MODE...................................... 106
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:POWer............................................ 106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:POWer......................................106
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:STATe?...........................................107
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:STATe?.................................... 107
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:MCODe?......................................... 107
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:PROTation.......................................107
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe............................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe:STATe.................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SDCode?.........................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SPOint.............................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:STATe.............................................109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SUCode...........................................109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:TDELay........................................... 109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:USERs............................................ 109

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:MODE
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:MODE <Mode>

Selects whether to use the pilot time slot and its power or not.

Parameters:
<Mode> AUTO | ON | OFF

*RST: AUTO

Example: BB:TDSC:DOWN:CELL1:DWPT:MODE ON
Manual operation: See "DwPTS Mode/ UpPTS Mode" on page 40

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:POWer
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:POWer <Power>

Sets the power of the downlink/uplink pilot time slot.

Parameters:
<Power> float

Range: -80  to  10
Increment: 0.01
*RST: 0

Example: BB:TDSC:DOWN:CELL1:DWPT:POW -12.5
sets the power of the downlink pilot slot.

Manual operation: See "DwPTS Power/ UpPTS Power" on page 40

 

Cell Settings



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

107Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:UPPTs:STATe?
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:STATe?
Queries the state of the downlink/uplink pilot timeslot.

Return values: 
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:TDSC:DOWN:CELL1:DWPT:STAT?
Usage: Query only

Manual operation: See "DwPTS Mode/ UpPTS Mode" on page 40

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:MCODe?

Queries the basic midamble code id. The value is set automatically by the change of
the scrambling code parameter (it is equal to scrambling code).

Return values: 
<MCode> integer

Range: 0  to  127
*RST: 0

Example: BB:TDSC:DOWN:CELL1:SCOD 15
Usage: Query only

Manual operation: See "Basic Midamble Code ID" on page 39

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:PROTation <PRotation>

Selects the phase rotation for the downlink pilots.

Parameters:
<PRotation> AUTO | S1 | S2

AUTO
Default phase rotation sequence according to the presence of
the P-CCPCH.
S1
There is a P-CCPCH in the next four subframes.
S2
There is no P-CCPCH in the next four subframes.
*RST: AUTO

Example: BB:TDSC:DOWN:CELL1:PROT AUTO
Manual operation: See "Phase Rotation" on page 40
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe <SCode>

Sets the scrambling code. The scrambling code is used for transmitter-dependent
scrambling of the chip sequence.

Parameters:
<SCode> integer

Range: 0  to  127
*RST: 0

Example: BB:TDSC:DOWN:CELL1:SCOD 15
sets the scrambling code for cell 1.

Manual operation: See "Scrambling Code" on page 39

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe:STATe <State>

Activates or deactivates the scrambling code.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:TDSC:DOWN:CELL1:SCOD:STAT ON
Manual operation: See "Use (Scrambling Code)" on page 39

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SDCode?

Queries the SYNC-DL code.

Return values: 
<SdCode> integer

Range: 0  to  31
*RST: 0

Example: BB:TDSC:DOWN:CELL1:SDC?
Usage: Query only

Manual operation: See "SYNC-DL Code" on page 40

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SPOint <SPoint>

Sets the switching point between the uplink slots and the downlink slots in the frame.

Parameters:
<SPoint> integer

Range: 1  to  6
*RST: 3

Example: BB:TDSC:DOWN:CELL1:SPO 4
Manual operation: See "Switching Point" on page 41
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:STATe <State>

Activates and deactivates the specified cell.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:STAT ON
Manual operation: See "Cell On / Cell Off" on page 23

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SUCode <SuCode>

Sets the SYNC-UL code.

Parameters:
<SuCode> integer

Range: 0  to  255
*RST: 0

Example: BB:TDSC:DOWN:CELL1:SUC 120
Manual operation: See "SYNC-UL Code" on page 40

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:TDELay <TDelay>

Sets the time shift of the selected cell compared to cell 1; the time delay of cell 1 is 0.

Parameters:
<TDelay> integer

Range: 0  to  19200
*RST: 0
Default unit: chip

Example: BB:TDSC:DOWN:CELL2:TDEL 100
'shifts cell 2 by 100 chips compared to cell 1.

Manual operation: See "Time Delay" on page 41

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:USERs <Users>

Sets the total number of users of the cell.

Parameters:
<Users> 2 | 4 | 6 | 8 | 10 | 12 | 14 | 16

*RST: 16

Example: BB:TDSC:DOWN:CELL1:USER 4
Manual operation: See "Number of Users" on page 41
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5.8 Enhanced Channels of Cell 1

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:SSPattern.................. 111
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TPCPattern................ 111
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TTINterval?................ 111
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:ANPattern.........................112
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:MODulation................ 112
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:VALue........................112
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:TTINterval?....................... 112
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:LAYer........................ 113
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:RATE.........................113
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:STATe....................... 113
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:RATE................... 114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:STATe..................114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BPFRame?.......................114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:CCOunt............................114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

CRCSize.............................................................................................................115
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:DATA... 115
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

DATA:DSELect....................................................................................................116
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

DATA:PATTern....................................................................................................116
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

EPRotection........................................................................................................ 116
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:IONE...........................117
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:ITWO.......................... 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:IONE.... 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:ITWO... 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

RMATtribute........................................................................................................117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:STATe..117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

TBCount............................................................................................................. 118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:TBSize..118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

TTINterval...........................................................................................................118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:RUPLayer?.......................118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SCSMode........................ 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SFORmat?....................... 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SLOTstate<ch>.................119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:STATe............................. 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TSCount.......................... 120
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TYPE...............................120
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:BPFRame?............................ 120
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:CRCSize?....................121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA.......................... 121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:DSELect.............121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:PATTern............ 122
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[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:EPRotection?............... 122
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:RMATtribute?...............122
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:STATe.........................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBCount?.................... 123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBSize?.......................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TTINterval?..................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SCSMode?............................ 124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SFORmat?.............................124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SLOTstate<ch0>?.................. 124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:STATe...................................124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:TYPE?...................................125

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:SSPattern
<SsPattern>

Sets the sync shift pattern. The pattern length is 21 bits.

Parameters:
<SsPattern> 21 bits

*RST: #H0,3

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:PLCC:SSP #HA5,8
sets the sync shift pattern.

Manual operation: See "Sync Shift Pattern" on page 52

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TPCPattern
<TpcPattern>

Sets the TPC pattern. The pattern length is 21 bits.

Parameters:
<TpcPattern> 21 bits

*RST: #H0,3

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:PLCC:TPCP #HA5,8
sets the TPC pattern

Manual operation: See "TPC Pattern" on page 53

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TTINterval?

Queries the transmission time interval.

Return values: 
<TtInterval> 5MS | 10MS | 20MS | 40MS | 80MS

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:PLCC:TTIN?
queries the TTI value
Respose: 5ms

Usage: Query only
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Manual operation: See "Transmission Time Interval (TTI) – RMC PLCCH"
on page 52

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:ANPattern
<AnPattern>

Sets the ACK/NACK Pattern. The pattern has a maximal length of 36 bits; a "1" corre-
sponds to ACK, a "0" to NAK.

Parameters:
<AnPattern> 36 bits

*RST: #H7,3

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSIC:ANP #HAA,8
sets the ACK/NACK pattern

Manual operation: See "ACK/NAK Pattern" on page 54

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:MODulation
<Modulation>

Sets the CQI modulation.

Parameters:
<Modulation> QPSK | QAM16 | QAM64

*RST: QPSK

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSIC:CQI:MOD QAM16
sets the CQI modulation

Manual operation: See "CQI Modulation" on page 54

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:CQI:VALue
<Value>

Sets the CQI value.

Parameters:
<Value> integer

Range: 0  to  63
*RST: 0

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSIC:CQI:VAL 10
sets the CQI value

Manual operation: See "CQI Value" on page 54

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSICh:TTINterval?

Queries the transmission time interval.
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Return values: 
<TtInterval> 5MS | 10MS | 20MS | 40MS | 80MS

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSIC:TTIN?
Response: 5ms

Usage: Query only

Manual operation: See "Transmission Time Interval (TTI) – RMC HS-SICH"
on page 53

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:LAYer
<Layer>

Sets the layer in the coding process at which bit errors are inserted.

Parameters:
<Layer> TRANsport | PHYSical

*RST: TRANsport

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BIT:LAY TRAN
Manual operation: See "Insert Errors On" on page 54

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:RATE <Rate>

Sets the bit error rate.

Parameters:
<Rate> float

Range: 1E-7  to  0.5
Increment: 1E-7
*RST: 0.001

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BIT:RATE 5E-1
sets the bit error rate.

Manual operation: See "Bit Error Rate" on page 54

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:STATe
<State>

Activates or deactivates bit error generation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BIT:STAT ON
Manual operation: See "State (Bit Error)" on page 54
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:RATE
<Rate>

Sets the block error rate.

Parameters:
<Rate> float

Range: 1E-4  to  0.5
Increment: 1E-4
*RST: 0.1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BLOC:RATE 10E-1
sets the block error rate.

Manual operation: See "Block Error Rate" on page 55

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:STATe
<State>

Activates or deactivates block error generation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BLOC:STAT ON
Manual operation: See "State (Block Error)" on page 55

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BPFRame?

Queries the data bits in the DPDCH component of the DPCH frame at physical level.
The value depends on the slot format.

Return values: 
<BpFrame> string

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:BPFR?
Usage: Query only

Manual operation: See "Data Bits Per Frame (10 ms)" on page 48

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:CCOunt <CCount>

Sets the number of channels to be used.

The number of timeslots is set with the command
BB:TDSC:DOWN|UP:CELL1:ENH:DCH:TSCount.

Parameters:
<CCount> integer

Range: 1  to  16
*RST: 1(uplink), 2(downlink)

Enhanced Channels of Cell 1



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

115Operating Manual 1171.5260.12 ─ 16

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:CCO 2
Manual operation: See "Number of Channels (DCH)" on page 48

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
CRCSize <CrcSize>

Sets the type (length) of the CRC.

Parameters:
<CrcSize> NONE | 8 | 12 | 16 | 24

*RST: 16(DTCH), 12(DCCH)

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:CRCS?
queries the type (length) of the CRC.

Manual operation: See "Size Of CRC" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA <Data>

The command selects the data source for the specified channel.

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<Data> PN9 | PN11 | PN15 | PN16 | PN20 | PN21 | PN23 | DLISt |

ZERO | ONE | PATTern
PNxx
PRBS data as per CCITT with period lengths between 29-1 and
223-1 is generated internally.
DLISt
Internal data from a programmable data list is used. The data list
can be generated by the Data Editor or generated externally.
Data lists are selected in the "Select Data List" field. The data
list is selected with the command
BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:DSEL <data
list name>.

ZERO | ONE
Internal 0 and 1 data is used.
PATTern
A user-definable bit pattern with a maximum length of 64 bits is
generated internally. The bit pattern is defined in the "Pattern
entry field". The bit pattern is selected with the command
BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:PATT <bit
pattern>.

*RST: PN9

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:DATA PN9
selects PN9 as the data source of the transport channel.
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Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA:DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

For general information on file handling in the default and in a specific directory, see
section "MMEMory Subsystem" in the R&S SMx/AMU operating manual.

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<DSelect> string

Filename incl. file extension or complete file path

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:DATA DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:DATA:DSEL
"tdscdma_1"
selects file tdscdma_1 as the data source. This file must be in
specified directory and it must have the file extension
*.dm_iqd.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
DATA:PATTern <Pattern>

Sets the bit pattern

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:DATA:PATT
#H800FE038,30

Manual operation: See "Data Source" on page 49

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
EPRotection <EProtection>

Sets the error protection.

Parameters:
<EProtection> NONE | TURBo3 | CON2 | CON3

*RST: CON3

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:EPR CON2
sets the error protection.
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Manual operation: See "Error Protection" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:IONE <IOne>
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:ITWO <ITwo>
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

IONE <IOne>
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:

ITWO <ITwo>

Activates or deactivates the channel coding interleaver state 1 and 2 off all the trans-
port channels. Interleaver state 1 and 2 can only be set for all the TCHs together. Acti-
vation does not change the symbol rate.

Parameters:
<ITwo> 0 | 1 | OFF | ON

*RST: 1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:ITWO ON
Manual operation: See "Interleaver 2 State" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
RMATtribute <RmAttribute>

Sets the rate matching.

Parameters:
<RmAttribute> integer

Range: 16  to  1024
*RST: 256

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:RMAT 32
Manual operation: See "Rate Matching Attribute" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
STATe <State>

Sets the state of the transport channel.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: depends on channel

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:STAT ON
enables the transport channel.

Manual operation: See "DTCH On/DCCH On" on page 49
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TBCount <TbCount>

Sets the number of transport blocks for the TCH.

Parameters:
<TbCount> integer

Range: 1  to  24
*RST: 1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:TBC 2
Manual operation: See "Transport Blocks" on page 50

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TBSize <TbSize>

Sets the size of the transport block at the channel coding input.

Parameters:
<TbSize> integer

Range: 0  to  4096
*RST: 244(DTCH), 100(DCCH)

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:TBS 4096
sets the size of transport block of the channel coding input.

Manual operation: See "Transport Block Size" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:
TTINterval <TtInterval>

Sets the number of frames into which a TCH is divided. This setting also defines the
interleaver depth.

Parameters:
<TtInterval> 5MS | 10MS | 20MS | 40MS

*RST: 20MS(DTCH), 40MS(DCCH)

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:DTCH:TTIN 40MS
sets the number of frames into which a TCH is divided.

Manual operation: See "Transport Time Interval" on page 50

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:RUPLayer?

The command queries the resource units on the physical layer needed to generate the
selected channel.

Return values: 
<RupLayer> string
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Example: BB:TDSC:DOWN:CELL1:ENH:DCH:RUPL?
queries the resource units on the physical layer needed to gen-
erate the selected channel.

Usage: Query only

Manual operation: See "Resource Units On Physical Layer" on page 46

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SCSMode
<ScsMode>

Sets the spreading code selection mode for the used transport channels.

Parameters:
<ScsMode> AUTO | USER

*RST: AUTO

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:SCSM AUTO
Manual operation: See "Spreading Code Selection for Enhanced Channels"

on page 48

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SFORmat?

Queries the slot format of the selected channel.

Return values: 
<SFormat> string

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:SFOR?
Usage: Query only

Manual operation: See "Slot Format" on page 48

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SLOTstate<ch>
<SlotState>

Queries the state of the slots off cell 1 used to transmit the transport channel.

Parameters:
<SlotState> 0 | 1 | OFF | ON

*RST: depends on slot

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:SLOT 3?
queries the state of slot 3.

Manual operation: See "Mapping On Physical Channels: Select Slots To Use"
on page 47

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:STATe <State>

Activates or deactivates the enhanced state for the DCH channel coding.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:STAT ON
deactivates the enhanced state for the DCH channel.

Manual operation: See "State (DCH)" on page 45

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TSCount
<TsCount>

Sets the number of timeslots to be used.

Parameters:
<TsCount> integer

Range: 1  to  5
*RST: 1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:TSC 2
Manual operation: See "Number of Timeslots (DCH)" on page 48

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TYPE <Type>

The command sets the channel coding type.

Parameters:
<Type> RMC12K2 | RMC64K | RMC144K | RMC384K | RMC2048K |

HRMC526K | HRMC730K | UP_RMC12K2 | UP_RMC64K |
UP_RMC144K | UP_RMC384K | HSDPA | HSUPA | HS_SICH |
PLCCH | USER | USER
*RST: RMC12K2

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:TYPE RMC12K2
sets the channel coding type to RMC12K2.

Manual operation: See "Coding Type" on page 46

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:BPFRame?

Queries the data bits in the DPDCH component of the DPCH frame at physical level.
The value depends on the slot format.

Return values: 
<BpFrame> string

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:BPFR?
Usage: Query only

Manual operation: See "Data Bits Per Frame (10 ms)" on page 45
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[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:CRCSize?

The command queries the type (length) of the CRC.

Return values: 
<CrcSize> NONE | 8 | 12 | 16 | 24

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:CRCS?
queries the type (length) of the CRC.

Usage: Query only

Manual operation: See "Size Of CRC" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA <Data>

The command selects the data source for the specified channel.

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<Data> PN9 | PN11 | PN15 | PN16 | PN20 | PN21 | PN23 | DLISt |

ZERO | ONE | PATTern
PNxx
PRBS data as per CCITT with period lengths between 29-1 and
223-1 is generated internally.
DLISt
Internal data from a programmable data list is used. The data list
can be generated by the Data Editor or generated externally.
Data lists are selected in the "Select Data List" field. The data
list is selected with the command
BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:DSEL <data
list name>.

ZERO | ONE
Internal 0 and 1 data is used.
PATTern
A user-definable bit pattern with a maximum length of 64 bits is
generated internally. The bit pattern is defined in the "Pattern
entry field". The bit pattern is selected with the command
BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:PATT <bit
pattern>.

*RST: PN9

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA PN9
selects PN9 as the data source of the transport channel.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:
DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

Enhanced Channels of Cell 1



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

122Operating Manual 1171.5260.12 ─ 16

For general information on file handling in the default and in a specific directory, see
section "MMEMory Subsystem" in the R&S SMx/AMU operating manual.

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<DSelect> string

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:DSEL
"tdscdma_1"
selects file tdscdma_1 as the data source. This file must be in
the specified directory and must have the file extension
*.dm_iqd.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:
PATTern <Pattern>

Sets the bit pattern.

For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:DATA:PATT
#H800FE038,30

Manual operation: See "Data Source" on page 49

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:EPRotection?

Queries the error protection.

Return values: 
<EProtection> NONE | TURBo3 | CON2 | CON3

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:EPR?
Usage: Query only

Manual operation: See "Error Protection" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:RMATtribute?

Queries the rate matching.

Return values: 
<RmAttribute> integer

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:RMAT?
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Usage: Query only

Manual operation: See "Rate Matching Attribute" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:STATe <State>

Queries the state of the transport channel.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:STAT?

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBCount?

Queries the number of transport blocks for the TCH.

Return values: 
<TbCount> integer

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:TBC?
Usage: Query only

Manual operation: See "Transport Blocks" on page 50

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBSize?

Queries the size of the transport block at the channel coding input.

Return values: 
<TbSize> integer

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:TBS?
Usage: Query only

Manual operation: See "Transport Block Size" on page 51

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TTINterval?

Queries the number of frames into which a TCH is divided.

Return values: 
<TtInterval> 5MS | 10MS | 20MS | 40MS | 80MS

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:DTCH:TTIN?
Usage: Query only

Manual operation: See "Transport Time Interval" on page 50
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[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SCSMode?

Queries the spreading code predetermined in the standard.

Return values: 
<ScsMode> AUTO

*RST: AUTO

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:SCSM?
Usage: Query only

Manual operation: See "Spreading Code Selection (BCH)" on page 45

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SFORmat?

The command queries the slot format of the selected channel. A slot format defines the
complete structure of a slot made of data and control fields and includes the symbol
rate. The slot format (and thus the symbol rate, the pilot length, and the TFCI State)
depends on the coding type selected.

Return values: 
<SFormat> string

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:SFOR?
queries the channel coding type.

Usage: Query only

Manual operation: See "Slot Format" on page 45

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SLOTstate<ch0>?

Queries the state of the slots off cell 1 used to transmit the broadcast channels.

Slot 0 is always on and all the other slots are always off.

Return values: 
<SlotState> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:SLOT1?
Usage: Query only

Manual operation: See "Mapping On Physical Channels: BCH mapped to <Slot> 0,
P-CCPCH1/2" on page 44

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:STATe <State>

Activates and deactivates the enhanced state for the P-CCPCH 1/2 channel.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: BB:TDSC:DOWN:CELL1:ENH:BCH:STAT ON
Manual operation: See "State (BCH)" on page 44

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:TYPE?

The command queries the channel coding type.

Return values: 
<Type> BCHSfn

Example: BB:TDSC:DOWN:CELL1:ENH:BCH:TYPE?
queries the channel coding type.

Usage: Query only

Manual operation: See "Coding Type (BCH)" on page 44

5.9 Channel Settings
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:

DPCCh:TPC:DATA:DSELect................................................................................ 130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:

DPCCh:TPC:DATA:PATTern................................................................................ 131
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TPC:READ..............................................................................................131

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
ENHanced?.........................................................................................................132

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:MSHift?..132
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:POWer...133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:SCODe.. 133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:SFACtor.133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:

SFORmat............................................................................................................134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:STATe... 134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:TYPE.....134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:USER.... 135
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:DCONflict?.................... 135
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:STATe.......................... 135
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:MODE......................................135
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA.....................136
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:DSELect....... 136
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:PATTern.......137
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:LENGth..................137
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:MSHift?..................137
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:PCORrection.......... 138
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:POWer...................138
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SCODe.................. 138
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFACtor................. 139
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFORmat?............. 139
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:STATe................... 139
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:USER.................... 139
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:DISTance................ 140
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:PCORrection?..........140
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:POWer....................140
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:PSTep.....................141
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:REPetition............... 141
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:STARt..................... 141
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:SLENgth?....................... 142

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:CCOunt <CCount>

Sets the number of the E-DCH Uplink Control Channels (E-UCCH).

Parameters:
<CCount> integer

Range: 0  to  8
*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT1:CHAN7:TYPE E_PUCH_QPSK
sets channel type E-PUCH QPSK
BB:TDSC:UP:CELL1:SLOT1:CHAN7:DPCC:EUCC:CCO 5
sets number of E-UCCH channels
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Manual operation: See "Number of E-UCCH Channels" on page 74

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:HPID <Hpid>

Sets the HARQ process ID.

Parameters:
<Hpid> integer

Range: 0  to  3
*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT1:CHAN7:TYPE E_PUCH_QPSK
sets channel type E-PUCH QPSK
BB:TDSC:UP:CELL1:SLOT1:CHAN7:DPCC:EUCC:HPID 2
sets number HARQ process ID

Manual operation: See "HARQ Process ID" on page 74

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:RSNumber <RsNumber>

Sets the retransmission sequence number.

Parameters:
<RsNumber> integer

Range: 0  to  3
*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT1:CHAN7:TYPE E_PUCH_QPSK
sets channel type E-PUCH QPSK
BB:TDSC:UP:CELL1:SLOT1:CHAN7:DPCC:EUCC:RSN 2
sets retransmission sequence number

Manual operation: See "Retransmission Sequence Number (E-UCCH)" on page 74

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:EUCC:TFCI <Tfci>

Enters the value of the TFCI field.

Parameters:
<Tfci> integer

Range: 0  to  63
*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT1:CHAN7:TYPE E_PUCH_QPSK
sets channel type E-PUCH QPSK
BB:TDSC:UP:CELL1:SLOT1:CHAN7:DPCC:EUCC:TFCI 10
sets the TFCI value

Manual operation: See "E-TFCI Value" on page 74

Channel Settings



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

128Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DATA <Data>

The command determines the data source for the selected channel.

Parameters:
<Data> PN9 | PN11 | PN15 | PN16 | PN20 | PN21 | PN23 | DLISt |

ZERO | ONE | PATTern
PNxx
PRBS data as per CCITT with period lengths between 29-1 and
223-1 is generated internally.
DLISt
Internal data from a programmable data list is used.
ZERO | ONE
Internal 0 and 1 data is used.
PATTern
A user-definable bit pattern with a maximum length of 64 bits is
generated internally.
*RST: PN9

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DATA PN9
sets the data source for the selected channel to PN9.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DATA:DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

Parameters:
<DSelect> string

Example: BB:TDSC:UP:CELL1:SLOT3:CHAN6:DATA DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:UP:CELL1:SLOT3:CHAN6:DATA:DSEL
"tdscdma_1"
selects file tdscdma_1 as the data source. This file must be in
the directory and must have the file extension *.dm_iqd.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DATA:PATTern <Pattern>

Determines the bit pattern. The first parameter determines the bit pattern (choice of
hexadecimal, octal, or binary notation), the second specifies the number of bits to use.

Parameters:
<Pattern> 64 bits

*RST: #H0,1
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Example: BB:TDSC:UP:CELL1:SLOT3:CHAN6:DATA:PATT #H3F, 8
defines the bit pattern.

Manual operation: See "Data" on page 69

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:SYNC:LENGth <Length>

Sets the length of the sync shift and the length of the TPC field in bits. The available
values depend on the slot format.

Parameters:
<Length> 0 | 2 | 3 | 4 | 8 | 16 | 32 | 48

*RST: 0

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:SYNC:LENG 2
Manual operation: See "Number of Sync Shift & TPC Bits" on page 73

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:SYNC:PATTern <Pattern>

Sets the bit pattern for the sync shift.

Parameters:
<Pattern> string

The maximum pattern length is 64 bits.

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:SYNC:PATT
10-01

Manual operation: See "Sync Shift Pattern" on page 73

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:SYNC:REPetition <Repetition>

Sets the value for the sync shift repetition.

Parameters:
<Repetition> integer

Range: 1  to  8
*RST: 1

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:SYNC:REP 1
Manual operation: See "Sync Shift Repetition M" on page 73

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TFCI:LENGth <Length>

Sets the length of the TFCI field in bits.

Channel Settings



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

130Operating Manual 1171.5260.12 ─ 16

Parameters:
<Length> 0 | 4 | 6 | 8 | 12 | 16 | 24 | 32 | 48

*RST: 0

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TFCI:LENG
12
sets the length of the TFCI field to 12 bits.

Manual operation: See "Number of TFCI Bits" on page 72

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TFCI:VALue <Value>

The command sets the value of the TFCI field.

Parameters:
<Value> integer

Range: 0  to  1023
*RST: 0

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TFCI:VAL 0
sets the value of the TFCI field to 0.

Manual operation: See "TFCI Value" on page 72

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TPC:DATA <Data>

Sets the data source for the TPC field of the DPCCH.

Parameters:
<Data> ZERO | ONE | PATTern | DLISt

DLISt
A data list is used.
ZERO | ONE
Internal 0 and 1 data is used.
PATTern
Internal data is used.
*RST: PATTern

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TPC:DATA
PATT
BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TPC:DATA:
PATT #H3F,8

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TPC:DATA:DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.
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For the traffic channels, this value is specific for the selected radio configuration.

Parameters:
<DSelect> string

Example: BB:TDSC:DOWN:CELL1:SLOT3:CHAN5:DPCC:TPC:DATA
DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:DOWN:CELL1:SLOT3:CHAN5:DPCC:TPC:DATA:
DSEL "tdscdma_1"
selects file tdscdma_1 as the data source. This file must be in
the directory and must have the file extension *.dm_iqd.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TPC:DATA:PATTern <Pattern>

Sets the bit pattern. The maximum bit pattern length is 64 bits.

Parameters:
<Pattern> 64 bits

*RST: #H1,2

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TPC:DATA:
PATT #H3F,8
defines the bit pattern.

Manual operation: See "TPC Source" on page 75

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
DPCCh:TPC:READ <Read>

Sets the read out mode for the bit pattern of the TPC field.
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Parameters:
<Read> CONTinuous | S0A | S1A | S01A | S10A

CONTinous
The TPC bits are used cyclically.
S0A
The TPC bits are used once and then the TPC sequence is con-
tinued with 0 bits.
S1A
The TPC bits are used once and then the TPC sequence is con-
tinued with 1 bit.
S01A
The TPC bits are used once and then the TPC sequence is con-
tinued with 0 and 1 bits alternately
S10A
The TPC bits are used once, and then the TPC sequence is
continued with 1 and 0 bits alternately
*RST: CONTinuous

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:DPCC:TPC:READ
S01A

Manual operation: See "Read Out Mode" on page 75

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
ENHanced?

Queries the enhanced state. If the enhanced state is set to ON, the channel coding
cannot be changed.

Return values: 
<Enhanced> 0 | 1 | 2 | OFF | ON | NOvalue

*RST: NOvalue

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:ENH?
Usage: Query only

Manual operation: See "Enhanced" on page 68

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
MSHift?

Queries the midamble shift.

Return values: 
<MShift> integer

Range: 0  to  128
*RST: 120

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:MSH?
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Usage: Query only

Manual operation: See "Midamble Shift" on page 72

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
POWer <Power>

Sets the channel power in dB.

Parameters:
<Power> float

Range: -80  to  0
Increment: 0.01
*RST: 0

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:POW -20
Manual operation: See "Power/dB" on page 68

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
SCODe <SCode>

Sets the spreading code for the selected channel. The code channel is spread with the
set spreading code. The range of values of the spreading code depends on the chan-
nel type and the spreading factor. Depending on the channel type, the range of values
can be limited.

Parameters:
<SCode> integer

Range: 1  to  16
*RST: 1

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:SCOD 1
set the spreading code for channel 6 to 1.

Manual operation: See "Sprd. Code" on page 68

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
SFACtor <SFactor>

Sets the spreading factor for the selected channel. The selection depends on the chan-
nel type and interacts with the slot format.

Parameters:
<SFactor> 1 | 2 | 4 | 8 | 16

*RST: 16

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:SFAC 16
Manual operation: See "Sprd. Fact." on page 68
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
SFORmat <SFormat>

Sets the slot format for the selected channel. A slot format defines the complete struc-
ture of a slot made of data and control fields and includes the symbol rate. The slot
format displays changes when a change is made to the "Number of TFCI Bits" and the
"Number of Sync Shift & TPC Bits" field settings.

Parameters:
<SFormat> integer

Range: 0  to  69
*RST: -

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:SFOR 0
sets the slot format for channel 6 to 0.

Manual operation: See "Slot Format" on page 68

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
STATe <State>

Activates or deactivates the channel.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT3:CHAN6:STAT ON
Manual operation: See "State" on page 70

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
TYPE <Type>

Sets the channel type.

In the uplink, the channel type is fixed for channel number 0. In the downlink, the chan-
nel type is fixed for channel numbers 0 to 5. For the remaining numbers, the choice lies
between the relevant standard channels and the high speed channels.

Parameters:
<Type> P_CCPCH1 | P_CCPCH2 | S_CCPCH1 | S_CCPCH2 | FPACH |

PDSCH | DPCH_QPSQ | DPCH_8PSQ | HS_SCCH1 |
HS_SCCH2 | HS_PDS_QPSK | HS_PDS_16QAM | PUSCH |
UP_DPCH_QPSK | UP_DPCH_8PSK | HS_SICH |
HS_PDS_64QAM | E_PUCH_QPSK | E_PUCH_16QAM |
E_RUCCH | PLCCH | EAGCH | EHICH
*RST: depends on channel number

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:TYPE DPC_QPSK
sets the channel type DPC_QPSK for channel 6 of the channel
table.
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Manual operation: See "Channel Type" on page 67

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:
USER <User>

Sets the number of the user.

Parameters:
<User> integer

Range: 1  to  16
*RST: 1

Example: BB:TDSC:DOWN:CELL4:SLOT3:CHAN6:USER 3
sets the number of the users to 3.

Manual operation: See "Crt.User/Mid.Shift" on page 68

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:DCONflict?

Queries the global domain conflict state per slot.

Return values: 
<DConflict> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:UP:CELL1:SLOT3:DCON?
Usage: Query only

Manual operation: See "Dom. Conf." on page 70

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:STATe <State>

Activates and deactivates the slot in the subframe.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:SLOT0:STAT ON
Manual operation: See "Slot Icon" on page 42

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:MODE <Mode>

Sets the mode in which the slot is to work.
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Parameters:
<Mode> DEDicated | PRACh

DEDicated
The instrument generates a signal with a dedicated physical
control channel (DPCCH) and up to six dedicated physical data
channels (DPDCH). The signal is used for voice and data trans-
mission.
PRACh
The instrument generates a single physical random access
channel (PRACH). This channel is needed to set up the connec-
tion between the mobile station and the base station.
*RST: DEDicated

Example: BB:TDSC:UP:CELL4:SLOT3:MODE PRAC
Manual operation: See "Slot Mode" on page 65

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA
<Data>

The command determines the data source for the PRACH.

Parameters:
<Data> PN9 | PN11 | PN15 | PN16 | PN20 | PN21 | PN23 | DLISt |

ZERO | ONE | PATTern
PNxx
PRBS data as per CCITT with period lengths between 29-1 and
223-1 is generated internally.
DLISt
Internal data from a programmable data list is used.
ZERO | ONE
Internal 0 and 1 data is used.
PATTern
A user-definable bit pattern with a maximum length of 64 bits is
generated internally.
*RST: PN9

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:DATA PN9
selects PN9 as the data source for the PRACH.

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:
DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

Parameters:
<DSelect> string

Filename incl. file extension or complete file path
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Example: BB:TDSC:UP:CELL1:SLOT3:PRAC:MSG:DATA DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:UP:CELL1:SLOT3:PRAC:MSG:DATA:DSEL
"tdscdma_1"
Selects file tdscdma_1 as the data source. This file must be in
the directory and it must have the file extension *.dm_iqd

Manual operation: See "Data List Management…" on page 18

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:DATA:
PATTern <Pattern>

Determines the bit pattern. The first parameter determines the bit pattern (choice of
hexadecimal, octal or binary notation), the second specifies the number of bits to use.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:TDSC:UP:CELL1:SLOT3:PRAC:MSG:DATA:PATT #H3F,
8
defines the bit pattern.

Manual operation: See "Data Source (PRACH)" on page 79

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:LENGth
<Length>

Sets the message length of the random access channel in subframes.

Parameters:
<Length> 1 | 2 | 4

*RST: 1

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:LENG 1
Manual operation: See "Message Length" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:MSHift?

Queries the value of the midamble shift.

Return values: 
<MShift> integer

Range: 0  to  128
*RST: 120

Example: BB:TDSC:UP:CELL1:SLOT3:PRAC:MSG:MSH?
Usage: Query only

Manual operation: See "Midamble Shift (PRACH)" on page 80
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[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:
PCORrection <PCorrection>

Queries the value of the power correction.

Parameters:
<PCorrection> float

Range: -1E10  to  1E10
Increment: 0.01
*RST: -

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:POW -10
sets the power of the PRACH message part
BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:PCOR?
queries the value of the power correction.
Response: 2.99086185076844

Manual operation: See "Power (RACH Message Part)" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:POWer
<Power>

Sets the power of the PRACH message part.

Parameters:
<Power> float

Range: -80  to  0
Increment: 0.01
*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:POW 1
Manual operation: See "Power (RACH Message Part)" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SCODe
<SCode>

Sets the spreading code for the PRACH. The code channel is spread with the set
spreading code.

Parameters:
<SCode> integer

Range: 1  to  16
*RST: 1

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:SCOD 16
sets the power of the PRACH message part.

Manual operation: See "Spreading Code (PRACH)" on page 79

Channel Settings



Remote-Control CommandsTD-SCDMA, incl TD-SCDMA enhanced features

139Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFACtor
<Sfactor>

Sets the spreading factor for the PRACH.

Parameters:
<Sfactor> 4 | 8 | 16

*RST: 16

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:SFAC 16
Manual operation: See "Spreading Factor (PRACH)" on page 79

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:SFORmat?

Queries the slot format of the PRACH. The slot format depends on the selected
spreading factor.

Return values: 
<SFormat> integer

Range: 0  to  25
*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:SFOR 1
Usage: Query only

Manual operation: See "Slot Format (PRACH)" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:STATe
<State>

Activates or deactivates the RACH (random access channel) message part.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:STAT ON
Manual operation: See "State (RACH Message Part)" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:MSG:USER
<User>

Sets user number.

Parameters:
<User> integer

Range: 1  to  16
*RST: 1

Example: BB:TDSC:UP:CELL1:SLOT3:PRAC:MSG:USER 1
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Manual operation: See "Current User (PRACH)" on page 80

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:DISTance
<Distance>

Sets the value to vary the timing between UpPTS and RACH.

Parameters:
<Distance> integer

Range: 1  to  4
*RST: 1

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:DIST 1
Manual operation: See "Distance UpPTS" on page 77

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:
PCORrection?

Queries the power correction of the UpPTS.

The value is computed based on:
● UpPTS power

BB:TDSC:UP:CELL:SLOT:PRAC:PTS:POW
● Power step

BB:TDSC:UP:CELL:SLOT:PRAC:PTS:PST
● Message power

BB:TDSC:UP:CELL:SLOT:PRAC:MSG:POW
● UpPTS length, message length

BB:TDSC:UP:CELL:SLOT:PRAC:MSG:LENG
● ARB sequence length

BB:TDSC:SLEN
Return values: 
<PCorrection> float

Range: -1E10  to  1E10
Increment: 0.01
*RST: 19.03

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:POW -12
BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:PCOR?
Response: 0.8890863332626

Usage: Query only

Manual operation: See "Power" on page 77

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:POWer
<Power>

Sets the power of the UpPTS.
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Parameters:
<Power> float

Range: -80  to  0
Increment: 0.01
*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:POW -12
Manual operation: See "Power" on page 77

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:PSTep
<PStep>

Sets the power by which the UpPTS is increased from repetition to repetition.

Parameters:
<PStep> float

Range: 0  to  10
Increment: 0.01
*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:PST 3
Manual operation: See "Power Step" on page 77

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:REPetition
<Repetition>

Sets the number of UpPTS repetitions before a PRACH burst happens.

Parameters:
<Repetition> integer

Range: 1  to  10
*RST: 1

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:REP 1
Manual operation: See "UpPTS Repetition" on page 78

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:PTS:STARt
<Start>

Sets the number of the subframe in which the first UpPTS should be transmitted.

Parameters:
<Start> integer

Range: 0  to  10
*RST: 0

Example: BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:STAR 3
Manual operation: See "UpPTS Start" on page 77
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[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:SLOT<ch0>:PRAC:SLENgth?

Queries the sequence length of the PRACH slot.

The value is computed based on:
● Start Subframe

BB:TDSC:UP:CELL:SLOT:PRAC:PTS:STAR
● UpPTS repetition

BB:TDSC:UP:CELL:SLOT:PRAC:PTS:REP
● Distance UpPTS and RACH

BB:TDSC:UP:CELL:SLOT:PRAC:PTS:DIST
● Message length

BB:TDSC:UP:CELL:SLOT:PRAC:MSG:LENG
Return values: 
<SLength> float

Range: 0.5  to  13.5
Increment: 0.5
*RST: 0.5

Example: BB:TDSC:UP:CELL:SLOT:PRAC:PTS:STAR 3
Sets the number of the subframe in which the first UpPTS is
transmitted.
BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:REP 2
Sets the number of UpPTS repetitions before a PRACH burst
happens.
BB:TDSC:UP:CELL4:SLOT3:PRAC:PTS:DIST 2
Sets the number of the subframe in which the first UpPTS is
transmitted.
BB:TDSC:UP:CELL4:SLOT3:PRAC:MSG:LENG 1
Sets the message length of the random access channel to one
subframe.
BB:TDSC:UP:CELL4:SLOT3:PRAC:SLEN?
Queries the sequence length.
Response: 3.5

Usage: Query only

Manual operation: See "Sequence Length" on page 77

5.10 HSDPA/HSUPA Settings

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:RMC......................... 143
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SCCH....................... 144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SPATtern?.................144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TBS:TABLe............... 144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TTIDistance............... 145
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:UEID.........................145
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[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:EUCTti............................145
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:FRC................................146
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSEQuence.................... 146
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSNumber?.................... 146
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:SFACtor..........................147
[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:TBS:TABLe..................... 147
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

BPAYload?......................................................................................................... 147
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:CRATe?...148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

CTSCount...........................................................................................................148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:DATA.......148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

DATA:DSELect....................................................................................................149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

DATA:PATTern....................................................................................................149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

HARQ:LENGth.................................................................................................... 149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

HARQ:MODE...................................................................................................... 150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:MIBT?......150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

MODulation.........................................................................................................150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:NCBTti?...151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

RVParameter...................................................................................................... 151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

RVSequence.......................................................................................................151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

SFORmat?..........................................................................................................152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:TBS:

INDex................................................................................................................. 152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:TSCount.. 152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

TTINterval?......................................................................................................... 153
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:

UECategory?.......................................................................................................153

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:RMC <Rmc>

Enables a predefined set of RMC channels or fully configurable user mode.

Parameters:
<Rmc> HRMC_0M5_QPSK | HRMC_1M1_QPSK |

HRMC_1M1_16QAM | HRMC_1M6_QPSK |
HRMC_1M6_16QAM | HRMC_2M2_QPSK |
HRMC_2M2_16QAM | HRMC_2M8_QPSK |
HRMC_2M8_16QAM | HRMC_64QAM_16UE |
HRMC_64QAM_19UE | HRMC_64QAM_22UE | USER
*RST: HRMC_0M5_QPSK
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Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:RMC
HRMC_2M8_QPSK
sets the RMC mode

Manual operation: See "RMC Configuration" on page 56

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SCCH
<Scch>

Enables/disables the HS-SCCH.

Parameters:
<Scch> 0 | 1 | OFF | ON

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:SCCH ON
Manual operation: See "HS-SCCH State" on page 58

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SPATtern?

Queries the distribution of packets over time.

The signaling pattern is cyclically repeated.

Return values: 
<SPattern> string

A sequence of HARQ-IDs and "-".
A HARQ-ID indicates a packet, a "-" indicates no packet.

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:TTID 2
BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:HARQ:LENG 4
BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:SPAT?
Response: '0,-,1,-2,-,3,-'

Usage: Query only

Manual operation: See "Signaling Pattern" on page 63

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TBS:TABLe
<Table>

Sets the transport block size table, according to the specification 3GPP TS 25.321.

Parameters:
<Table> C1TO3 | C4TO6 | C10TO12 | C7TO9 | C13TO15 | C16TO18 |

C19TO21 | C22TO24
*RST: C1TO3

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:TSB:TABL
C13TO15

Manual operation: See "Transport Block Size Table" on page 61
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[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TTIDistance
<TtiDistance>

Sets the inter-TTI distance. The inter-TTI is the distance between two packets in
HSDPA packet mode and determines whether data is sent each TTI or there is a DTX
transmission in some of the TTIs.

An inter-TTI distance of 1 means continuous generation.

Parameters:
<TtiDistance> integer

Range: 1  to  8
*RST: 1

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:TTID 2
Manual operation: See "Inter TTI Distance" on page 62

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:UEID <Ueid>

Sets the UE identity.

Parameters:
<Ueid> integer

Range: 0  to  65535
*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:UEID 2
sets the UE ID

Manual operation: See "UEID (H-RNTI)" on page 58

[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:VIBSize
<VibSize>

Sets the size of the virtual IR buffer.

Parameters:
<VibSize> integer

Range: dynamic  to  63360
Increment: 704
*RST: 2816

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:VIBS 2800
sets the size of the virtual IR buffer

Manual operation: See "Virtual IR Buffer Size (Per HARQ process)" on page 62

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:EUCTti <Euctti>

Sets the number of E-UCCH channels per TTI.
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Parameters:
<Euctti> integer

Range: 1  to  8
*RST: 4

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:EUCT 2
sets the number of channels

Manual operation: See "Number of E-UCCH per TTI" on page 59

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:FRC <Frc>

Selects a predefined E-DCH fixed reference channel or fully configurable user mode.

Parameters:
<Frc> 1 | 2 | 3 | 4 | USER

*RST: 1

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:EUCT 2
Manual operation: See "E-DCH Fixed Reference Channel (FRC)" on page 57

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSEQuence
<RSequence>

(for "HSUPA" and "HARQ Mode" set to constant NACK)

Sets the retransmission sequence.

Parameters:
<RSequence> string

*RST: 0

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:TYPE HSUPA
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:HARQ:MODE CNAC
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:RSEQ '0,2,3'

Manual operation: See "Retransmission Sequence" on page 64

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:RSNumber?

(for HARQ Mode set to constant ACK)

Queries the retransmission sequence number.

The value is fixed to 0.

Return values: 
<RsNumber> integer

Range: 0  to  0
*RST: 0
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Example: BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:HARQ:MODE CACK
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:RSN?
Response: 0

Usage: Query only

Manual operation: See "Retransmission Sequence Number" on page 64

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:SFACtor
<SFactor>

Selects the spreading factor for the FRC.

Parameters:
<SFactor> 1 | 2 | 4 | 8 | 16

*RST: 4

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:SFAC 2
sets the spreading factor

Manual operation: See "Spreading Factor (FRC)" on page 59

[:SOURce<hw>]:BB:TDSCdma:UP:CELL<st>:ENH:DCH:HSUPA:TBS:TABLe
<Table>

Sets the transport block size table, according to the specification 3GPP TS 25.321,
annex BC.

Parameters:
<Table> C1TO2 | C3TO6

*RST: C1TO2

Example: BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:TBS:TABL C3TO6
Manual operation: See "Transport Block Size Table 0" on page 61

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
BPAYload?

Queries the payload of the information bit. i.e. transport block size. This value deter-
mines the number of transport layer bits sent in each TTI before coding.

Return values: 
<BPayload> integer

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:BPAY?
Usage: Query only

Manual operation: See "Information Bit Payload (Ninf)" on page 62
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
CRATe?

Queries the coding rate.

Return values: 
<CRate> float

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:CRAT?
Usage: Query only

Manual operation: See "Coding Rate (HSDPA/HSUPA)" on page 62

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
CTSCount <CtsCount>

Sets the number of physical channels per timeslot.

Parameters:
<CtsCount> integer

Range: 1  to  14
*RST: 10(downlink), 1(uplink)

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:CTSC
2

Manual operation: See "Number of HS-PDSCH/E-DCH Codes per TS" on page 59

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA <Data>

The command determines the data source for the HSDPA/HSUPA channels.

Parameters:
<Data> PN9 | PN11 | PN15 | PN16 | PN20 | PN21 | PN23 | DLISt |

ZERO | ONE | PATTern
PNxx
PRBS data as per CCITT with period lengths between 29-1 and
223-1 is generated internally.
DLISt
Internal data from a programmable data list is used.
ZERO | ONE
Internal 0 and 1 data is used.
PATTern
A user-definable bit pattern with a maximum length of 64 bits is
generated internally.
*RST: PN9

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:DATA
PN11
selects the data source
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Manual operation: See "Data Source (HSDPA/HSUPA)" on page 60

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA:DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

Parameters:
<DSelect> string

Filename incl. file extension or complete file path

Example: BB:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:DATA DLIS
MMEM:CDIR "<root>Lists"
BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:DATA:
DSEL "tdscdma_1"
Selects file tdscdma_1 as the data source.This file must be in
the directory and must have the file extension *.dm_iqd

Manual operation: See "Data Source (HSDPA/HSUPA)" on page 60

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
DATA:PATTern <Pattern>

Determines the bit pattern. The first parameter determines the bit pattern (choice of
hexadecimal, octal or binary notation), the second specifies the number of bits to use.

Parameters:
<Pattern> 64 bits

*RST: #H0,1

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:DATA:
PATT #H3F, 8
defines the bit pattern.

Manual operation: See "Data Source (HSDPA/HSUPA)" on page 60

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
HARQ:LENGth <Length>

Sets the number of HARQ processes. This value determines the distribution of the
payload in the subframes and depends on the inter-TTI distance.

A minimum of three HARQ Processes are required to achieve continuous data trans-
mission.

Parameters:
<Length> integer

Range: 1  to  8
*RST: 4

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:HARQ:LENG 5
Manual operation: See "Number of HARQ Processes" on page 62
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[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
HARQ:MODE <Mode>

Sets the HARQ simulation mode.

Parameters:
<Mode> CACK | CNACk

CACK
New data is used for each new TTI. This mode is used to simu-
late maximum throughput transmission.
CNACk
Enables NACK simulation, i.e. depending on the sequence
selected with command
BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:RVS packets are
retransmitted. This mode is used for testing with varying redun-
dancy version.
*RST: CACK

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:HARQ:
MODE CNAC
sets the HARQ mode

Manual operation: See "HARQ Mode" on page 63

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
MIBT?

Queries maximum information bits sent in each TTI before coding.

Return values: 
<Mibt> float

Increment: 0.1

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:MBIT?
Usage: Query only

Manual operation: See "Maximum Information Bit Throughput /kbps" on page 58

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
MODulation <Modulation>

Sets the modulation scheme for each HSDPA RMC or HSUPA FRC.

The HSUPA FRCs do not support modulation scheme 64QAM.

Parameters:
<Modulation> QPSK | QAM16 | QAM64

*RST: QPSK

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:MOD
QAM16
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Manual operation: See "Modulation (HSDPA/HSUPA)" on page 60

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
NCBTti?

Queries the number of bits after coding.

Return values: 
<NcbTti> integer

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:NCBT?
Usage: Query only

Manual operation: See "Number of Coded Bits Per TTI" on page 60

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
RVParameter <RvParameter>

(for HARQ Mode set to constant ACK)

Sets the redundancy version parameter, i.e. indicates which redundancy version of the
data is sent.

Parameters:
<RvParameter> integer

Range: 0  to  7
*RST: 0

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:HARQ:
MODE CACK
BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:RVP 2

Manual operation: See "Redundancy Version Parameter" on page 63

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
RVSequence <RvSequence>

(for HARQ Mode set to constant NACK)

Sets the retransmission sequence.

The sequence has a length of maximum 30 values. The sequence length determines
the maximum number of retransmissions. New data is retrieved from the data source
after reaching the end of the sequence.

For HSUPA, the command is a query only.

Parameters:
<RvSequence> string

*RST: 0
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Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:HARQ:
MODE CNAC
BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:RVS '0,2,1'
BB:TDSC:DOWN:CELL1:ENH:DCH:TYPE HSUPA
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:HARQ:MODE CNAC
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:RSEQ '0,2,3'
BB:TDSC:UP:CELL1:ENH:DCH:HSUPA:RVS?
Response: '0,2,1'

Manual operation: See "Redundancy Version Sequence" on page 64

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
SFORmat?

Queries the slot format of the selected channel.

A slot format defines the complete structure of a slot made of data and control fields.
The slot format depends on the coding type selected.

Return values: 
<SFormat> string

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:SFOR?
Usage: Query only

Manual operation: See "Slot Format (HSDPA/HSUPA)" on page 59

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TBS:INDex <Index>

Sets the index for the corresponding table, as described in 3GPP TS 25.321.

Parameters:
<Index> integer

Range: 0  to  63
*RST: -

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:TBS:
IND 20

Manual operation: See "Transport Block Size Index" on page 61

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TSCount <TsCount>

Sets the number of timeslots.

Parameters:
<TsCount> integer

Range: 2  to  5
*RST: 2
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Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:TSC 3
Manual operation: See "Number of HS-PDSCH/E-DCH Timeslots" on page 59

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
TTINterval?

Queries the transmission time interval (TTI).

Return values: 
<TtInterval> 5MS

Example: BB:TDSC:DOWN|UP:CELL1:ENH:DCH:HSDPA|HSUPA:TTIN?
Response: 5MS

Usage: Query only

Manual operation: See "Transmission Time Interval (TTI)" on page 59

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:
UECategory?

Queries the UE category that is minimum required to receive the selected RMC or
FRC.

Return values: 
<UeCategory> integer

Example: BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:RMC
HRMC_2M8_16QAM
BB:TDSC:DOWN:CELL1:ENH:DCH:HSDPA:UEC?
Response: 13

Usage: Query only

Manual operation: See "UE Category" on page 58

HSDPA/HSUPA Settings



List of CommandsTD-SCDMA, incl TD-SCDMA enhanced features

154Operating Manual 1171.5260.12 ─ 16

List of Commands
[:SOURce<hw>]:BB:TDSCdma:CLIPping:LEVel.............................................................................................92
[:SOURce<hw>]:BB:TDSCdma:CLIPping:MODE............................................................................................92
[:SOURce<hw>]:BB:TDSCdma:CLIPping:STATe........................................................................................... 92
[:SOURce<hw>]:BB:TDSCdma:CLOCk:MODE.............................................................................................102
[:SOURce<hw>]:BB:TDSCdma:CLOCk:MULTiplier...................................................................................... 102
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SOURce......................................................................................... 103
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:EXECute............................................................ 103
[:SOURce<hw>]:BB:TDSCdma:CLOCk:SYNChronization:MODE................................................................ 103
[:SOURce<hw>]:BB:TDSCdma:COPY:DESTination.......................................................................................85
[:SOURce<hw>]:BB:TDSCdma:COPY:EXECute............................................................................................ 85
[:SOURce<hw>]:BB:TDSCdma:COPY:SOURce.............................................................................................85
[:SOURce<hw>]:BB:TDSCdma:CRATe:VARiation..........................................................................................86
[:SOURce<hw>]:BB:TDSCdma:CRATe?.........................................................................................................85
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:MODE...............................................................106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:POWer..............................................................106
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:DWPTs:STATe?............................................................ 107
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:BPFRame?................................................... 120
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:CRCSize?..........................................121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA................................................. 121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:DSELect..................................121
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:DATA:PATTern..................................122
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:EPRotection?.....................................122
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:IONE..................................................117
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:ITWO................................................. 117
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:RMATtribute?.....................................122
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:STATe................................................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBCount?...........................................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TBSize?............................................. 123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:DTCH:TTINterval?........................................123
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SCSMode?................................................... 124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SFORmat?....................................................124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:SLOTstate<ch0>?.........................................124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:STATe...........................................................124
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:BCH:TYPE?.......................................................... 125
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:RMC................................................143
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SCCH..............................................144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:SPATtern?.......................................144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TBS:TABLe..................................... 144
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:TTIDistance.....................................145
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:UEID................................................145
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:HSDPA:VIBSize........................................... 145
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:SSPattern.........................................111
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TPCPattern...................................... 111
[:SOURce<hw>]:BB:TDSCdma:DOWN:CELL<st>:ENH:DCH:PLCCh:TTINterval?...................................... 111
[:SOURce<hw>]:BB:TDSCdma:DOWN:PPARameter:PCCPch:STATe........................................................105
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:LAYer............................................... 113
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:RATE............................................... 113

 



List of CommandsTD-SCDMA, incl TD-SCDMA enhanced features

155Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BIT:STATe..............................................113
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:RATE......................................... 114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BLOCk:STATe........................................114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:BPFRame?............................................. 114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:CCOunt...................................................114
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:CRCSize.................. 115
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:DATA........................115
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:DATA:DSELect........ 116
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:DATA:PATTern........ 116
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:EPRotection............. 116
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:IONE........................ 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:ITWO........................117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:RMATtribute............. 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:STATe...................... 117
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:TBCount................... 118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:TBSize......................118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:DTCH<ch>|DCCH:TTINterval................ 118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:BPAYload?.................. 147
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:CRATe?....................... 148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:CTSCount.................... 148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:DATA........................... 148
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:DATA:DSELect............ 149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:DATA:PATTern............149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:HARQ:LENGth.............149
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:HARQ:MODE...............150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:MIBT?.......................... 150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:MODulation..................150
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:NCBTti?....................... 151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:RVParameter............... 151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:RVSequence................151
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:SFORmat?...................152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:TBS:INDex...................152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:TSCount.......................152
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:TTINterval?.................. 153
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:HSDPA|HSUPA:UECategory?............... 153
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:RUPLayer?............................................. 118
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SCSMode............................................... 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SFORmat?..............................................119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:SLOTstate<ch>...................................... 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:STATe.................................................... 119
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TSCount................................................. 120
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:ENH:DCH:TYPE...................................................... 120
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:MCODe?.................................................................. 107
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:PROTation............................................................... 107
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe.....................................................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SCODe:STATe........................................................ 108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SDCode?................................................................. 108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DATA......................... 128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DATA:DSELect..........128
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DATA:PATTern..........128



List of CommandsTD-SCDMA, incl TD-SCDMA enhanced features

156Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:SYNC:
LENGth....................................................................................................................................................129

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:SYNC:
PATTern.................................................................................................................................................. 129

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:SYNC:
REPetition................................................................................................................................................129

[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TFCI:LENGth129
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TFCI:VALue..130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TPC:DATA....130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TPC:

DATA:DSELect........................................................................................................................................130
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TPC:

DATA:PATTern........................................................................................................................................131
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:DPCCh:TPC:READ... 131
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:ENHanced?............... 132
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:MSHift?......................132
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:POWer.......................133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:SCODe...................... 133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:SFACtor.....................133
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:SFORmat...................134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:STATe....................... 134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:TYPE......................... 134
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:CHANnel<us0>:USER.........................135
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:DCONflict?...........................................135
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SLOT<ch0>:STATe................................................. 135
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SPOint......................................................................108
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:STATe......................................................................109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:SUCode................................................................... 109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:TDELay.................................................................... 109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:CELL<st>:USERs..................................................................... 109
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:COUNt..................................................... 104
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:CRESt......................................................104
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:DPCH:SFACtor................................................... 105
[:SOURce<hw>]:BB:TDSCdma:DOWN|UP:PPARameter:EXECute............................................................. 105
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:APCO25.........................................................................93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:COSine...........................................................................93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:GAUSs........................................................................... 93
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASs............................................................................ 94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:LPASSEVM....................................................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:PGAuss..........................................................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:RCOSine........................................................................94
[:SOURce<hw>]:BB:TDSCdma:FILTer:PARameter:SPHase..........................................................................95
[:SOURce<hw>]:BB:TDSCdma:FILTer:TYPE................................................................................................. 92
[:SOURce<hw>]:BB:TDSCdma:LINK.............................................................................................................. 86
[:SOURce<hw>]:BB:TDSCdma:POWer:ADJust..............................................................................................86
[:SOURce<hw>]:BB:TDSCdma:POWer[:TOTal]?............................................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:BBONly............................................................................................ 87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:FDELay............................................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:RDELay............................................................................................87
[:SOURce<hw>]:BB:TDSCdma:PRAMp:SHAPe............................................................................................. 88



List of CommandsTD-SCDMA, incl TD-SCDMA enhanced features

157Operating Manual 1171.5260.12 ─ 16

[:SOURce<hw>]:BB:TDSCdma:PRAMp:TIME................................................................................................ 88
[:SOURce<hw>]:BB:TDSCdma:PRESet..........................................................................................................88
[:SOURce<hw>]:BB:TDSCdma:RESet............................................................................................................88
[:SOURce<hw>]:BB:TDSCdma:SETTing:CATalog?....................................................................................... 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:LOAD..............................................................................................89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe........................................................................................... 89
[:SOURce<hw>]:BB:TDSCdma:SETTing:STORe:FAST................................................................................. 90
[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel..........................................................................................90
[:SOURce<hw>]:BB:TDSCdma:SETTing:TMODel:CATalog?.........................................................................90
[:SOURce<hw>]:BB:TDSCdma:SLENgth........................................................................................................95
[:SOURce<hw>]:BB:TDSCdma:STATe........................................................................................................... 90
[:SOURce<hw>]:BB:TDSCdma:TRIGger:ARM:EXECute................................................................................96
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXECute.........................................................................................96
[:SOURce<hw>]:BB:TDSCdma:TRIGger:EXTernal:SYNChronize:OUTPut....................................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:DELay........................................................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OBASeband:INHibit........................................................................97
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut:DELay:FIXed.................................................................. 100
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay.....................................................................100
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MAXimum?................................................. 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:DELay:MINimum?.................................................. 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:MODE.....................................................................101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:OFFTime................................................................ 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:ONTime.................................................................. 101
[:SOURce<hw>]:BB:TDSCdma:TRIGger:OUTPut<ch>:PERiod................................................................... 102
[:SOURce<hw>]:BB:TDSCdma:TRIGger:RMODe?.........................................................................................97
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